(Gmbarcadero

Product Documentation

ER/Studio Team Server XEb6
User Guide

Version 4.0.3




© 2014 Embarcadero Technologies, Inc. Embarcadero, the Embarcadero Technologies logos,
and all other Embarcadero Technologies product or service names are trademarks or registered
trademarks of Embarcadero Technologies, Inc. All other trademarks are property of their
respective owners.

Embarcadero Technologies, Inc. is a leading provider of award-winning tools for application
developers and database professionals so they can design systems right, build them faster and
run them better, regardless of their platform or programming language. Ninety of the Fortune
100 and an active community of more than three million users worldwide rely on Embarcadero
products to increase productivity, reduce costs, simplify change management and compliance
and accelerate innovation. The company's flagship tools include: Embarcadero® Change
Manager™, CodeGear™ RAD Studio, DBArtisan®, Delphi®, ER/Studio®, JBuilder® and Rapid
SQL®. Founded in 1993, Embarcadero is headquartered in San Francisco, with offices located
around the world. Embarcadero is online at www.embarcadero.com.

September, 2014

Embarcadero Technologies 2


http://www.embarcadero.com/

CONTENTS

What Is ER/Studio Team SEIVEr ......cciiiiiiiiiiic e, 8
Installation Notes for ER/Studio Team Server ..o, 9
MiNIMUM REGQUITEIMENTS ..ottt ettt ettt e e e 9
Hardware REQUITEMENTS ......c.ooiiiiiicii e 9
SYSTEM REQUITEMENTS ...ttt 9
ER/StUIO REPOSITONY ..eiiiiitiieii e 10
Supported Database Platforms ..o 10
IMportant INFOrmMation ..o 10
SUPPOrtEd Web BrOWSErS .....c..ioiiiiieiieieieci s 11
CONTIICES ot M

P r OO QUISITES ..ttt ettt ettt e e 11
OPtIONAI FEATUMNES ...ttt 11
Active Directory USErs SUPPOI ..cc.iiiiiiiieii it 11
EM@il SUPPOM ..t 11
Third-Party Software That Is Installed with ER/Studio Team Server.........cccccovininee. 12
Installing and Upgrading .......coioiiiiiiiiiee e 12
AT INSTAIlING .ot 12
Upgrade Notes for ER/Studio Team SErver........cccooiiiveiiiiiiieeeet e 13
Upgrading from Embarcadero CONNECT 3.0.X c.cuveiiiiiiiiieiiiciceieee e 13
Upgrading from ER/Studio Portal 2.0.X c..c..ciiiiiiiiieiiieeceeeeeee e 13
Upgrading from ER/Studio Portal 1.6.X c..ceeiiiiiiiieiiiieeeeeeeee e 14
Upgrading ER/Studio Team Server.........ccii it 15
USEI GUIE .ttt ettt a ettt eeeeneenens 17
Connecting to ER/Studio Team SErver ......cccciiiiiiiiiiiiee e, 18
Overview of User Configuration ... 19
Changing the Default Limit of Filters per Filtering Option.........cccocoveiviviiiiiiice 20
Changing the Default Number of Results per Page.........ccoooeveiiiiiiiniiicee, 21
Changing Your Email Address for Notifications ..........ccoceeiiiiiniiiiicccee 22
Configuring Your User Profil@.........c.oiiii e 23
USING SOCIAl FEATUIES ...t 24
Interface for SOCial USErS ........c.iiiiiiii e 24
INteraction With RESOUICES ........ouiiiiiiieice e 24
SAICIING ettt ettt ettt 26
USING REPOIES. .. 27
Adding a Shared Report to Favorite REPOItS ......ccoiviiiiiiiiiiceceee e, 28
Generating @ Shared REPOI ..ot 30
Sending Reports By EMail .....coiiiiiiii e 31
WOrking With RESOUICES.......c.iiiiiiiiiieiet e 32
Adding an Attachment Attribute to a Resource Type ......ccocoieieiiiiiiicceee e 33
Deleting @ RESOUITE .....cuiiiiiiiee ettt 34
DISCUSSING RESOUITES ...ttt 35
Starting a Discussion about @ RESOUICE .......ccciiiiiiiiiiiiicee e 36
Editing @ RESOUICTE ..ottt 37

Embarcadero Technologies 3



Editing the Stewards of @ RESOUICE .......oiiiiiiii 38

FOIOWING RESOUITES ..ot 39
FOIOWING @ RESOUITE ...t 40
Posting a Comment to @ RESOUICE ......cviiiiiiiiiiiic e 41
UNTOIOWING @ RESOUITE ... 42
INteracting With PEOPIE ....c.iiiiiic e 43
Loading Glossaries and Terms from a CSV File......ccoooviiiiiiiiiie A1
CSV Format to Load Glossaries and TerMS ........coeiriiiiiiriiiiciecececeeee e 45
Properties that You Can Use in Your CSV File ..o, 45
GlOSSANY PrOPEIIES ...ttt 46
TEIMN PrOPEITIES . ettt et eneee e 46
CUSTOM ATEIDULES .. 47
Examples of Valid CSV Files ..o 48
SINGIE GlOSSAMNY ...ttt 48
TOITNS .ttt 48
Searching for a Resource of a Specific Resource Type ......ccocoviveieiiiiiiceee, 49
WOrking With GIOSS@IES .....c.veuiiiiiiieiei e 50
Adding a Child t0 @ GlIOSSAIY....c.cieiiiiiieiiiee e 51
Adding @ Term t0 @ GlOSSAIY....couiiiiiiiiieeet e 52
Creating @ GlOSSAIY ... ot 53
GIOSSAIY TOOI THD ettt ettt 54
Installing Glossary TOO! TIPS ..ot s 55
WOTKING WIth TEIMS 1..oeiiii e 56
Associating a Term with @ GlOSSAry ........ccooirieiiiiiiceee s 57
Associating a Term with an ER OBjJect ..o 58
Associating a Term with ANOther TEMM . ..oooioi i 59
Creating @ TOIMN . ettt 60
LINKEA TOIMNIS ...ttt ettt 61
Matching a Term with ER ODbjJECts ....ooioiiiiiiiic e 62
Working With Data SOUICES ......c.iiiiiiiiiiiici e 63
Associating a Data Source with an ER Model ... 64
Associating a Data Source with a Login Credential ..........ccocooioiiiiniiiiiicce 65
VW TAD ettt ettt 65
REIGEE T -t 65
Creating @ Data SOUICE ..ottt 6/
Data Source Fields for a Specific Database Management System ..........ccccoocvveveiennnnn. 68
DB2 LUW .ttt 69
DB2 Z/OS e 69
IO BaS .ttt 69
FITEDITA ettt 70
DB ettt 70
IMYSQIL ettt 70
ODB ettt 71
OFACIE ettt 71
Connecting to Oracle With Alias.........cociiiiiiiii e 72

Embarcadero Technologies 4



Connecting to Oracle with Connect Descriptor .........cccoviiiiiriiiicceceeee 72

Connecting to Oracle With SID ..o 72
Connecting to Oracle with Service Name ........ocooiiiiiiiiiiiie 72
SQOL AZUTE e 73
SO SEIVET ... 73

S DS s 73
SYD@SE QD o 74
Working with Login Credentials..........ccoiiiiiiiiiiec e 75
Creating Login Credentials .........oooiiiiie e 76
EQItiNg @ RESOUITE ..ottt 77
Deleting Login CredentialS. ... ..o 78
Browsing LOgin Credentials..... ..o 79
Related Login Credentials ..o 80
VIBW T ettt 80
REIGEE T - 80
LOGin Credential Pages. . ..oi i 82
Login Credentials Pages Header ........coiiiiiiiiieccee e 82
Login Credentials Pages Sidebar.........cocooiiiiiiiiic e 82
ACCess CONTrol PEIrMISSIONS. ...t it 83
USEIS TAD ettt ettt 83
GrOUPS TAD ettt 83
Manage User Permissions on @ RESOUICE .......cc.iivuiiiiiiiiiiiiiiiiiiicceeee e, 85
Manage Group Permissions on @ RESOUICE ........coiiiiiiiiiiiiiiiiiciecct e 87
Creating @ Permissions GrOUD........ciiiiiiii ittt 89
Deleting @ Permissions GrOUD.........oiiiiiieiei ettt 90
IMIONITOTING ottt ettt ettt et ettt ettt ettt ettt e 1
MaiNtENANCE WINAOW ...ttt 93
Data SOUICE ALBITS. ...ttt 94
Working With ER ODJECES ....cvviiiiiiiiicie e 95
Associating an ER Object with @ Term ... 96
Browsing ER OBJECES ...c..cuiiiiiiiiiiiee e 97
Configuring Sensitive Data AlSItS .......ccoiiiiiiie e 98
Adding a Sensitive Data Alert Condition ........ccciviriiiiiiic e 99
Deleting a Sensitive Data Alert Condition ..........cccoiiireieiiiceee e 100
Editing a Sensitive Data Alert Condition...........ocooieiiiiiiiec e, 101
Matching an ER Object With TErMS ....couiiiiiiiiiecc s 102
Using the Advanced Search of ER ObjJects .......oociiiiiiiiiiciccce e, 103
Searching for an ER Object Using the Advanced Search ........ccccooeiiiiiiiiiiccs 104
SaVING FaVvorite SEAIrCRES ......c.i it 106
Sending Searches By EMail ..o 107
Writing an Advanced Search STriNg . ..cociiiiiiiiiec e, 108
USING LOGIC OPEIatOrS ...ttt 108
Making Mandatory or Excluding Words ..........ccooiiiiiiiiiicieieeeeee e 108
Using Wildcard CharaCters ........c.oociieiiiiieie e 108
Using the Similarity and Proximity Character.........ccocooiviiiiiiiiicicccccee, 109

Embarcadero Technologies 5



Escaping Special CharaCters .........oooeieiiiiieeee e 109

Working with ER Object CommMENtS......cociiiiiiiicic e 110
Adding a Comment to an ER OBJecCt.....cc.civiiiiiiiiicc 1M1
Deleting a Comment from an ER ObjJECt .......cccoviiiiiiiiiiiieceec e 113
See the Comments to an ER ODjJECT.......oooiiiiiiiiiiiieee e 114
Watching ER Objects for New CommeNnts.......cocviiviiiiiiiiicecee e 115
Working with ER Object Labels.........ccooiiiiiii e 116
Editing the Labels of an ER Object......ccooiiiiiiiiiice e, 117
Overview of the User Interface ... 118
PAGE INAEX 1.ttt 118
GlODal SEACH BOX...eiiiiiiieiiieie et 120
SIMPIE SEAICK ...ttt ettt 121
SIMPle SEArCh FOMM ..o 122
SEAICIN RESUITS ...t 123
RESUIS HEAAEN ..t 123
RESUILS Panel ... 124
FIEIS Pan@l...eieee e 125
Search Results Configuration .......co.ccioiiiiiie s 128
Column Header ACHIONS . ......oii e 128
Search Results Configuration ACIONS.........cooiiiiiiiii e, 129
RESOUICE PAGES ...ttt et 130
GlOSSANY PAgES...iiiiieie e 132
Glossary Pages Header .......ooiiiiiiiec e 132
Glossary Pages Sidebar........ooiiiiiii e 132
GlOSSArY DESCIIPTION vttt ettt 134
Details COlUMN ..o 134
StEWArdS COlUMN ..o 134
CRITAIEN ettt 136
MANAGE TAD .. 136
TEIM PAOES ettt ettt 137
Term Pages HEAder .. ...o.i it 137
Term Pages SIdebar .......oii i 137
TN DESCIIPIION 1.ttt ettt e et e et e e et eeensaeeenneeens 139
Details COlUMN ..o 139
StEWArdS COlUMN ..o 139
Related ER OBDJECLS ..ot 141
VIBW TAD .ttt 141
FOUN TN TAD 1. 141
REIAE TAD 1t 142
Related GlOSSAIIES . ...uiiuieiiiieeit ettt 143
REIAE TAD 1t 143
Data SOUICE PAgES ...ttt 144
Data Source Pages HEAder .. ..c.oiiiiiiiiii e 144
Data Source Pages Sidebar ........oociiiiiiiii e 144
Data SOUMCE DeSCriPION .. ittt ettt 146

Embarcadero Technologies 6



Dtails COlUMIN e 146

STEWATAS COUMN ...ttt 147

D IS CUSSIONS ..ttt ettt ettt et a e i bttt ettt ettt ene e 148
ER ODJECT PAgES ...ttt 150
ER Object Pages HEader ......ciiiiiiiiicc e 150
ER Object Pages Sidebar.........oiiiiiiiiiiieee e 150
Sidebar for SOCIal USErS ....oouiiiiiiiiiiee e 150
Sidebar for Non-Social USErs........ccviiiiiiiiiiicceee e, 151
AALBIES ..ttt ettt n ettt ne ettt neene e 152
Alert Condition ENTIES......oiiiiicieieet et 152
ER Object DESCIIPTION ..ottt 155
TrOUBIESNOOTING ..ttt 158
Cannot Connect to ER/Studio Team Server ... 158
UNable 10 CONNECT ..ottt 158
Template Could Not be Loaded.........ccoooiiiiiiiiiiiiiceceee e, 158
Loading Pages Takes Too MUCHh TiMe ..ot 158
LOG ErTOr IMESSa0ES. ...ttt 158
tomcat\logs\<domain>.<date>.10g .....cccoiiiiiiiiiii 158
etlvar\log\log_<timestamp>\*.10g ....ccoooiiiiiiii e 159
SYNCHAIONIZATION ISSUES ....iviiiiiiiiitieie ettt 159
GlOSSAIY 1ttt 161
ettt h et h et h ettt 161

B ettt ettt sttt h et n ettt 161
ettt ettt 161
DD ettt ettt 161
ekttt ettt 162
OO OO OO OO O U SOUUSO RSO UO PR 162

P ettt h ettt h et h e h ettt 162

R ettt ettt bttt a sttt ettt 162

S ettt ettt ettt et ekttt ettt et ettt ettt ettt ene e 163

T ettt ekttt etk ek h ettt h ettt en e 163

Embarcadero Technologies 7



What Is ER/Studio Team Server

What |Is ER/Studio Team Server

ER/Studio Team Server is a web-based tool to access, search, edit and manage enterprise
metadata. It provides access to metadata from ER/Studio Repository, and it allows you to
manage additional metadata, such as glossaries and terms or data sources.

ER/Studio Team Server allows you to keep track of your metadata and discuss its evolution
with other users. It also lets you create reports easily from your data and searches, and export
them to different file formats.

ER/Studio Team Server also enables you to:

e Search for all kinds of data, such as data definitions and ER objects in any model of your
ER/Studio Repository database, including ER/Studio Data Architect and ER/Studio
Business Architect diagrams. ER/Studio Team Server has simple and advanced
searching capabilities to find ER objects and other resources, as well as their reuse and
impact analysis.

o Browse all the contents of your ER/Studio Repository database, such as models and
dictionaries, in a structured way.

Using a web browser, you can access ER/Studio Team Server internally, via your corporate
intranet, or externally, via the internet. This way, you can access all the information you need
from anywhere.

Data Architect Web Browser

:. i;,l. : t_' :-_l _.'
o f_ + H \
..- . ) ) ‘
8 = Fyi || ER/studio | Sync P
4 |‘ : !' f‘j ~ Repository I

Business Architect

Database
Server

LI

See Also

e Overview of the ER/Studio Team Server Architecture

e |nstalling ER/Studio Team Server

e User Guide
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Installation Notes for ER/Studio Team Server

Installation Notes for ER/Studio Team
Server

These notes provide important information about installing ER/Studio Team Server. You should
read this document in its entirety before any install or uninstall procedure.

Minimum Requirements

ER/Studio Team Server is a 32-bit server application that runs in a Microsoft Windows
environment. Before installing ER/Studio Team Server, verify that your environment meets the
hardware and operating system requirements.

Hardware Requirements

The minimum hardware requirements are:

e CPU:2x3.0Ghz

@Note: Should you be running the minimum spec requirements, it is advised to reduce the
maxThreads to a single thread. To do this, edit ...tomcat>webapps>api>WEB-INF>ersportal-
app.xml and change the line <property name="maxThreads" value="2" />, to have a value of
"1" (a restart is required after saving the change).

e RAM: 4GB

o Disk space: 740 MB for program installation. You will need additional space available for
data storage, for example 100mb per diagram in the Repository.

Recommended hardware:
e CPU:4x3.0Ghz
e RAM:8GB

System Requirements

Your machine must be running the Microsoft Windows operating system. The following versions
of Microsoft Windows are supported:

e Microsoft Windows 2012 Server

e Microsoft Windows 2008 R2 Server

e Microsoft Windows 2008 Server (32-bit or 64-bit)
e Microsoft Windows 2003 Server (32-bit only)

@Note: ER/Studio Team Server can run on Windows XP, Windows Vista and Windows 7-8,
but this is not recommended for an operational system, only for testing purposes.
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e Toinstall ER/Studio Team Server on Windows 7, you need to run the installer in
Windows XP or Windows Vista compatibility mode.

e If the SQL server is also running when installing on Windows 8, the instance needs to be
part of the SQL server name. The services and protocols also need to be running or
enabled as documented below for SQL Server 2014.

ER/Studio Repository

ER/Studio Team Server works against an installation of ER/Studio Repository. Prior to
installing ER/Studio Team Server, you need a working installation of ER/Studio Repository.
ER/Studio Team Server supports versions 6.0, and 6.5 of ER/Studio Repository.

If you have enough RAM for both applications, we recommend that you install ER/Studio Team
Server on the same machine where the ER/Studio Repository server is installed. Otherwise, the
machine where you install ER/Studio Team Server must have network access (over a local
network or over the Internet) to the machine where ER/Studio Repository is running.

Supported Database Platforms

The Reporting Repository is the database that ER/Studio Team Server uses to store the
information that it gathers from the ER/Studio Repository. The Reporting Repository database
also stores the reports from previous queries and the metadata they rely on.

The Reporting Repository database may run on any of the following database platforms:
e Oracle 9i, 10g, and 11g
e |BM DB2 UDB 8.x, 9.x and 10.x Server

@Note: Before installing ER/Studio Team Server on the DB2 platform, you must first
create the Reporting Repository database. Allocate 32K for the tablespace pagesize.

Starting with CONNECT version 3.0.4, Unicode is supported. When installing DB2, UTF-
8 should be selected when configuring your DB2 DB.

e Microsoft SQL Server 2005 to 2014

Important Information

Ensure that the database is set to case-insensitive, as case-sensitive is not supported. Also set
the SQL Server Configuration Properties to allow SQL Server authentication. ER/Studio Team
Server only supports SQL Server Authentication.

When installing over SQL Server 2014 (any Operating System), use the SQL Server
Configuration Manager and make sure that the following services are running:
SQL Server

SQL Server Agent

Also that following protocols are enabled:

Shared Memory

TCP/IP

Named Pipes

Embarcadero Technologies 10



Installation Notes for ER/Studio Team Server

Supported Web Browsers

The following web browsers are tested to work with ER/Studio Team Server. Other browsers
may work, but are not officially supported:

e Mozilla Firefox
e Google Chrome

e Microsoft Internet Explorer (7.0 or later)

Conflicts

Do not install ER/Studio Team Server on a system where ER/Studio Data Architect, ER/Studio

Business Architect or a previous version of ER/Studio Team Server is installed. If the ER/Studio

Team Server installer detects an installation of any of these applications, the installer asks you to
uninstall these applications before you proceed.

There may be naming conflicts between the ER/Studio Repository and the Reporting
Repository. If both repositories are installed on the same database server, you should use
different schema owners.

Prerequisites

To install ER/Studio Team Server:
e The installation user account must have local administrative privileges.

e The ER/Studio Repository server and the database server to be used for the ER/Studio
Team Server Reporting repository must be running.

e Inorder to install, you need to create first an empty database for ER/Studio Team
Server, unless you already have a database and will be reinitializing it during the install.

Optional Features

Active Directory Users Support

The installation must include configuration of LDAP functionality to allow directory service users
to log in to ER/Studio Team Server. You can alternatively enable LDAP authentication after the
installation.

Email Support

SMTP server configuration must be done in order to fully support email notifications based on
user activity. You can alternatively enable email support after the installation.
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Third-Party Software That Is Installed with ER/Studio
Team Server

ER/Studio Team Server depends on some third-party software that the ER/Studio Team Server
installation wizard installs automatically on your system. That third-party includes:

e Apache Tomcat

e Pentaho Bl Platform

Installing and Upgrading

If you meet the minimum requirements, you can proceed to install ER/Studio Team Server. See
Installing ER/Studio Team Server.

If you have installed a previous version of ER/Studio Team Server (for example, any version of
Embarcadero CONNECT or ER/Studio Portal), see Upgrading ER/Studio Team Server.

After Installing

After the installation is complete, you must synchronize the ER/Studio Team Server database
with the ER/Studio Repository database to ensure that it is up to date.

See Installing ER/Studio Team Server, Next Steps for more information.

See Also

e Release Notes for ER/Studio Team Server

e Upgrading from Previous Versions
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Upgrade Notes for ER/Studio Team Server

Upgrade Notes for ER/Studio Team Server

These Upgrade Notes provide important information regarding the process of upgrading to
Embarcadero Team Server 4.0 from a previous versions.

Regardless of the process that you must follow to back up your licenses, which depends on the
previous version that you are upgrading from and other factors, after you restore your licenses
in your new ER/Studio Team Server 4.0 installation, you must log in as a super user and use the
Manage Users page to assign different types of available licenses to your users.

@Note: Files saved in later versions of ER Studio Data Architect may not work with ER/Studio
Team Server if they use new features. For example, if you use SQL Server 2014 for your Physical
Model in ER Studio DA 9.7, you will need to update to the corresponding version of ER/Studio
Team Server for those files to synchronize.

Upgrading from Embarcadero CONNECT 3.0.x

If your previous installation is CONNECT 3.0.x, the installation with automatically detect an
upgrade to ER/Studio Team Server.

We always recommend backing up your data before starting the process. You may have to back
up your database, Repository database and export your Glossaries and Terms. We also
recommend that you back up any licenses. To do this, please follow the steps in Upgrading
from ER/Studio Portal 2.0.x.

Upgrading from ER/Studio Portal 2.0.x

If your previous installation is ER/Studio Portal 2.x, you will need to back up your licenses
manually.

Make a copy of the license files, for example: license txt, ao_ 12345678 txt or .slip until the
upgrade has completed. Then copy to the license folder in the installation directory of the new
ER/Studio Team Server installation folder.

Depending on your installation location, you can find the license file in the program directory.
For example:

o C:\Embarcadero\ERStudio Portal 2.0\license

If you have previously used the uninstaller, you may also have a license backup in the following
location:

o 32-bit Windows: C:\Program Files (x86)\Common
Files\ersEnterprisePortalBackup\license
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o 64-bit Windows: C:\Program Files\Common
Files\ersEnterprisePortalBackup\license

If you have installed ER/Studio Portal 2.0.x on one computer and now want to install
ER/Studio Team Server on a different computer, there is no license to back up, so you
must use the license file from the previous installation. Copy the license\license.txt file

from the previous installation folder into the new ER/Studio Team Server installation
folder.

After copying over the license.txt file to the license folder within the installation folder of
ER/Studio Team Server, log in to ER/Studio Team Server as a super user, select My Settings >
Admin > Licenses and click Refresh for ER/Studio Team Server to recognize your licenses.

Upgrading from ER/Studio Portal 1.6.x

ER/Studio Portal 1.6.x uses two databases, the solution and the reporting repositories. Because
of this, you need to follow these steps to upgrade to ER/Studio Team Server:

1.

o & >

Consolidate the two databases:

1. Stop the Tomcat service and run the 1.6.x Portal Configuration Manager.

Select the Solution Database tab.

Change the connection information to match that of the Reporting database.

2

3

4. Select Initialize Existing Database and click Apply.

5. Click OK. The Solution tables will be placed into the Reporting database.
6

Restart the Tomcat service.

Log in to the Portal and make sure that everything works correctly.

Uninstall Portal 1.6.x.

Install ER/Studio Team Server.

When prompted to specify the Reporting Database information, specify the connection
information, select Connect to Existing Database, and click Next. You are prompted to
specify the Solution database information. It should default to the Reporting database.

Specify the password for the Reporting database and click Next.
Finish the installation.

After installing ER/Studio Team Server, synchronize ER/Studio Team Server with the
ER/Studio Repository database to ensure that it is up to date.
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Upgrading ER/Studio Team Server

Upgrading ER/Studio Team Server

Before you begin, please review the Upgrade Notes specific to your previous version and the
Release Notes.

To upgrade your ER/Studio Team Server installation to a newer version:

1. Run the installer for ER/Studio Team Server, this will automatically uninstall your current
ER/Studio Team Server installation. If you wish to uninstall your previous version of
ER/Studio Team Server manually, please review, later in this topic, the information
regarding keeping your licenses.

2. Install your new version of ER/Studio Team Server.
Supported Versions for Upgrading

Upgrading releases of ER/Studio Portal prior to 2.0 is not supported for this release. Please
review the Upgrade Notes for further information.

@Note: In previous versions of ER/Studio Portal it was possible to split the Reporting and
Solutions database in two separate databases. If you have your Portal data in two separate
servers, you will need to use your database supporting client tools to merge the data into one
database prior to installation. Team Server no longer uses the solution/reporting database
structure. Should you have any concerns regarding this, please contact Support before starting
your upgrade.

Keeping Your Licenses When Upgrading

If you have previously installed ER/Studio Portal 2.x you will need to manually back up your
license file as explained below. If you are upgrading from Connect 3.x the Embarcadero
Connect installer will automatically back up and use your existing add-on license files. But there
are two exceptions:

e You are upgrading and during the installation you choose a different Reporting
repository than the one used in your previous installation. In this case you must copy the
license.txt file from the backup directory to the license directory in the new
Embarcadero Connect license directory, <installation folder>\license\. Depending on
the operating system, you can find the license file at one of these backup locations:

o C:\Program Files (x86)\Common Files\ersEnterprisePortalBackup\license
o C:\Program Files\Common Files\ersEnterprisePortalBackup\license

e You have installed a previous version on one computer and now want to install
Embarcadero Connect 3.0 on a different computer. In this case, there is no license to
back up so you must use the license file from the previous installation. Copy the
license.txt file from the previous installation to the new installation. The license file
resides in <installation folder>\license\.

Embarcadero Technologies 15


http://docwiki.embarcadero.com/TeamServer/ERStudio/en/Release_Notes_for_Embarcadero_Connect_3.0
http://docwiki.embarcadero.com/TeamServer/ERStudio/en/Uninstalling_ER/Studio_Team_Server
http://docwiki.embarcadero.com/TeamServer/ERStudio/en/Uninstalling_ER/Studio_Team_Server
http://docwiki.embarcadero.com/TeamServer/ERStudio/en/Installing_ER/Studio_Team_Server
http://www.embarcadero.com/support

Upgrading ER/Studio Team Server

After copying over the license file to <installation folder>\license\, from the Embarcadero
Connect console, go to Admin > Licenses, and click Refresh so that Embarcadero Connect
recognizes and uses the license.

Reports Update when Upgrading

This section explains how to deal with the upgrade from previous versions when the adhoc
report metadata changes with respect to the new version. Changes include adding new model
into an adhoc report, or changing field name in the existing adhoc report.

@Note: The following instructions affect the upgrade from previous versions in which
the adhoc report metadata changes with respect to the actual version. For example, the
Connect Model option is not available until Connect 3.0.2. For this reason, when
upgrading from releases prior to Connect 3.0.1 to versions Connect 3.0.2 or higher, you
should follow these steps. Particularly, when upgrading from Connect 3.0.2, the Connect
Model option appears on the New Report page but if you move to the next page, the
custom attribute options are missing until these steps are executed.

If the adhoc report metadata changes when you upgrade from a previous version, you should
follow the following steps after installing the new version:

1. Select My Settings > Admin > Repository Management.

2. Click More button.

3. Click on the options in the following order:
1. Refresh Reporting Metadata.
2. Execute Global Action.
3. Refresh System Settings.

4. Click Close.

5. Click Update Solution Repository in My Settings > Admin > Repository
Management.

6. Wait until a message of successful update appears.
After you upgrade ER/Studio Team Server

e Update the search index.

See Also

e |nstalling ER/Studio Team Server

e Uninstalling ER/Studio Team Server
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User Guide

User Guide

This volume of help describes how to use ER/Studio Team Server as a authenticated user.

Topics

e Connecting to ER/Studio Team Server

e Searching

e Working with Resources:

o Glossaries

o Terms
o People

o ER Objects

o Data Sources

» |Login Credentials

e Using Reports

e User Configuration

e User Interface

See Also

e Overview of the User Interface

e Administrator Guide
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Connecting to ER/Studio Team Server

Connecting to ER/Studio Team Server

Welsame te Embarcaders Team Server

To connect to a running instance of ER/Studio Team Server:

1. Open a web browser. See Supported Web Browsers.

2. Browse to the ER/Studio Team Server URL, as provided by your super user. The web
browser shows the ER/Studio Team Server login page.

o Tip: If you are the super user, see Starting ER/Studio Team Server for more
information.

3. Enter your Username and Password, as provided by your super user. The default user
being Admin > Admin.

4. Optionally, click "Remember me" to store your user credentials in the web browser, so
that you do not need to enter them again.

5. Click Login.

You should now be logged in to ER/Studio Team Server. If you are unsure of what to do next,
see the User Guide.

See Also

e Troubleshooting, Connecting to ER/Studio Team Server

e Starting ER/Studio Team Server

e Login Page
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Overview of User Configuration

Overview of User Configuration

You can define your user preferences from the Preferences page.

If you are a social user, you can customize additional user settings. For example, you can
configure your user profile from the Configure Profile page, or choose in the Notifications page
which activities you want to follow, so that you get email notifications about them.

Topics

e Configuring Your User Profile

e Changing the Default Limit of Filters per Filtering Option

e Changing the Default Number of Results per Page

e Changing Your Email Address for Notifications

See Also

e Preferences page

o Configure Profile page

e Notifications page
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Changing the Default Limit of Filters per Filtering Option

Changing the Default Limit of Filters per
Filtering Option

When you perform an advanced search as a social user or any search as a non-social user, the
search results page displays a panel with filtering options.

By default, under each filtering option there is a list of up to 25 filters that you can apply to the
current search. If more than 25 filters are available, you need to click /, so that it becomes
and the filter limit is ignored.

To change the default limit of filters that are listed under each filtering option, do the following:
1. Select My Settings > Preferences.
2. Click Edit to make your preferences editable.

3. Under Search, change the value of Default Filter Limitation to the desired value. The
value must be a positive integer.

4. Click Apply Changes to save your changes.

See Also

e Search Results page

e Preferences page
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Changing the Default Number of Results per Page

Changing the Default Number of Results
per Page

The Comments page displays 10 results per page by default. To change this value:

RN

Select My Settings > Preferences.

N

Click Edit to make your preferences editable.

3. Under General, change the value of Results per Page to the desired value. The value
must be a positive integer.

&

Click Apply Changes to save your changes.

See Also

e Search Results page

e Preferences page
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Changing Your Email Address for Notifications

Changing Your Email Address for
Notifications

To change the email address where you get ER/Studio Team Server notifications:

RN

Select My Settings > Preferences.

2. Click Edit to make your preferences editable.
3. Under Notifications, change the value of Email Address field to your new email
address.
4. Click Apply Changes to save your changes.
See Also

e \Watching ER Objects for New Comments

e Preferences page
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Configuring Your User Profile

Configuring Your User Profile

When you are a social user, other social users can search for you and see details about you in
your Description page.

To configure the information in your description page:

1. Open your person page. For example, click your username or user image in your Home
page.

2. Click Edit on the upper-right corner of your person page.

3. Inthe Configure Profile page:

1. In Photo, click Browse and select an image file that you want to represent you in
ER/Studio Team Server.

2. Fill Title with your job title. This field is mandatory.

w

You can enter in First Name your display name, which ER/Studio Team Server
displays in places such as the Stream subpage.

Write a detailed description of your job responsibilities in Job Description.
Fill your Phone number so other users can contact you by phone.

Fill Email with your email address.

A

Under Stream Moderation, you can check or uncheck the following options:

= "Allow others to post to your stream". Check this option so that other
users can post comments associated with your user.

= "Allow others to comment on activity in your stream". Check this option
so that other users can reply to items in your activity stream.

8. Click Save Changes to save your changes.

See Also

o Configure Profile page

e Interacting with People
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Using Social Features

Using Social Features
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ER/Studio Team Server provides two different user profiles: social and non-social. The social
version of ER/Studio Team Server is a useful system for users to share their experiences with
other users and keep track of the activity related to the resources of their interest.

The content of this page focuses on the features that ER/Studio Team Server offers to social
users. These features are not available for non-social users. See Overview of User Experiences
to understand the main differences between these two experiences.

Interface for Social Users

You can access features and settings with the User Menu of the interface and search for any
resource in the Reporting Repository using the Global Search Box option. The interface also
includes a Navigation Menu with the main ER/Studio Team Server features. See Overview of the
User Interface for more information about the interface.

Interaction with Resources
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You can interact with any resource (glossaries, terms, ER objects, and data sources). Interaction
includes having discussions (making comments) with other users about resources, tracking the
changes and discussions related to resources and following people activity surrounding
resources. For that purpose, you can use the following features:

e Stream

The Stream page shows the activity related to the current resource. This activity involves
changes surrounding resources, such as start following a resource, as well as comments
related to these changes. The activity stream is shown on the Home page and on the
current resource pages. On the Home page, you can filter the content in the activity
stream. See Stream page for more information.
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Using Social Features

e Discussions

You can see and edit comments related to a resource using the Discussions Tab of the
navigation sidebar. In the current resource page, you can select the Discussions option
to see the conversation about this resource or start a new one. A discussion can be
expanded to show other users' comments. Each entry displays the image, the username
and the actual text of the author and the date when the author wrote the reply. See
Discussing Resources for more information.

@Note: ER/Studio Team Server shows comments related to an ER Object made in ER/Studio
Data Architect. To view the comments click the icon next to the ER Object in the Model

Explorer.
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e Following a Resource
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You can track other users' activity in relation to resources. This activity appears on the
Home page when people that you are following edit resources, post comments to
resources, and so on. The Following a Resource feature provides a practical tool for the
personalization of the system according to the user's interests. See Following a Resource
for more information.

See Also

e Overview of User Experiences

e Overview of User Roles

e Overview of the User Interface

¢ Comment Moderation Page
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Searching

Searching

ER/Studio Team Server provides search boxes on several pages, as well as a global search box.
To use the subpage searches, start typing in the search box. As you type, the search results will
start to match what you have typed. To use any global search box, just enter your search terms
and press d.

If you are a social user, using the global search box you get a combination of the search results
that you get when you use the searches for glossaries, terms, people, ER objects, and data
sources. If you are a non-social user, the global search box lets you perform a simple search for

ER objects.

Both simple and advanced searches are executed against a search index that contains all
searchable text properties of the ER objects in the Reporting Repository database. Super users
can configure the search index so that searches ignore certain fields.

Simple searches check all the searchable properties of any ER object in the Reporting
Repository database for a partial match. After a simple search, ER/Studio Team Server provides
a table with the matching ER objects. Each row in the search results provides a link to the ER
object description page of the matching ER object, so that you can view more details on that ER
object. At the top of the page you can click one of the letters to filter the search results to only
those ER objects beginning with the chosen letter.

If the standard search features are not enough for your use case, you can use the advanced
search feature instead to look to ER objects, which allows you to refine your search with
additional parameters and search string syntax features. You can configure your advanced
search results page (click ‘-J-’) and you can save your advanced searches (click ) to access
them later from the Favorite Searches page, where you can email them, print them, and share
them.

See Also

e Advanced Search page

e Search Pages

e Configuring the Search Index
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Using Reports

Using Reports

ER/Studio Team Server provides several standard reports. You can access the standard reports
from the Solution Browser page. See Shared Reports for a list of available standard reports.

When you execute a standard report, you are prompted to supply custom parameters that filter
and format the results of the report. Those parameters depend on each other; that is, the value
that you choose for one parameter determines the available values for other parameters. For
example, if you select a certain project, you can only select diagrams that exist within the
selected project. See Generating a Shared Report to learn how to use standard reports.

ER/Studio Team Server lets you generate reports not only in HTML, but in PDF and XLS
(Microsoft Excel spreadsheet) as well. You can save reports to run later and share them with
other users. You can also print and email the reports.

Using the Web Adhoc Query and Reporting wizard, you can create your own custom reports,
and save them into the Solution Browser page, where you can organize them into folders. You
can run your custom reports whenever you want, and you can share them with other users.

The content of the custom reports is limited to the structured business views created using
metadata. The metadata module generates SQL code based on business views that you
specified during development. You can modify the business views using the Pentaho Metadata
software.

Topics

e Generating a Shared Report

e Adding a Shared Report to Favorite Reports

e Sending Reports By Email

See Also
e My Reports

e Solution Browser

e Web Adhoc Query and Reporting Wizard
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Adding a Shared Report to Favorite Reports

Adding a Shared Report to Favorite
Reports

You can save the parameters of a shared report in your list of Favorite Reports, so you can later
access the report easily.

To make a shared report favorite:

1. Open the Solution Browser page:

o As asocial user: ER Tools > Shared Reports.

o As anon-social user: Shared Reports.

2. Under Shared Reports, click either Business Reports or Technical Reports.

3. Click the name of the report you want to make favorite. For additional information about
the standard reports, see Shared Reports.

Note: Users can see all shared reports, regardless of whether or not they have
permission to access the ER objects that the report accesses. However, when users that
try to run a report that access ER objects which users do not have permission to access,
users get an error message instead of the results of the report.

4. On the Shared Report Configuration Page page that opens:

1. Choose the parameters for your report.

2. Inthe View as combo box, choose the desired type of output for the report
results: html, pdf or xls.

3. Click Add to Favorites.
5. In the Add to favorites dialog that opens:

0. Enter a Name to save the report with in the Favorite Reports list.

1. Write a Description for the report.
2. Check the Shared checkbox if you want to make the shared report public.
3. Click Submit to make the shared report favorite.

After you save your new report as favorite, you can find it in the Favorite Reports page. If you
are a non-social user, you can find your favorite reports in the Home page as well.

See Also

e Generating a Shared Report

e Favorite Reports

e Solution Browser
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Adding a Shared Report to Favorite Reports

e Shared Report Configuration Page page
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Generating a Shared Report

Generating a Shared Report

To generate a shared report:

1. Open the Solution Browser page:

o As asocial user: ER Tools > Shared Reports.

o As anon-social user: Shared Reports.

2. Under Shared Reports, click either Business Reports or Technical Reports.

3. Click the name of the report you want to run. For additional information about the
standard reports, see Shared Reports.

Note: Users can see all shared reports, regardless of whether or not they have
permission to access the ER objects that the report accesses. However, when users that
try to run a report that access ER objects which users do not have permission to access,
users get an error message instead of the results of the report.

4. On the Shared Report Configuration Page page that opens:

1. Choose the parameters for your report.

2. Inthe View as combo box, choose the desired type of output for the report
results: html, pdf or xls.

3. Click Run to generate the target report.

See Also

e Adding a Shared Report to Favorite Reports

e Solution Browser

e Shared Report Configuration Page page
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Sending Reports By Email

Sending Reports By Email

If emailing reports is enabled, follow these steps to send a report by email:

1. Open the Solution Browser page:

o As asocial user: ER Tools > Shared Reports.

o As anon-social user: Shared Reports.

2. Under Shared Reports, click either Business Reports or Technical Reports.

3. Click the name of the report you want to make favorite. For additional information about
the standard reports, see Shared Reports.

Note: Users can see all shared reports, regardless of whether or not they have
permission to access the ER objects that the report accesses. However, when users that
try to run a report that access ER objects which users do not have permission to access,
users get an error message instead of the results of the report.

4. On the Shared Report Configuration Page page that opens:

1. Choose the parameters for your report.

2. Inthe View as combo box, choose the desired type of output for the report
results: html, pdf or xls.

3. Click Send by Email.
5. In the Email Report dialog that opens:
0. Specify in To an email address of the recipient.

1. Click Submit to send the message.

See Also

e Generating a Shared Report

e Adding a Shared Report to Favorite Reports

e Enabling Emailing Search Results and Reports

e Favorite Reports
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Working with Resources

Working with Resources

ER/Studio Team Server gives you access to various types of resources:

Glossaries
Terms
People

ER Objects

Data Sources

The following topics are shared by more than one type of resource:

Searching for a Resource of a Specific Resource Type

Editing a Resource

Discussing Resources

Following Resources

Editing the Stewards of a Resource

Adding an Attachment Attribute to a Resource Type

Loading Glossaries and Terms from a CSV File

Deleting a Resource

See Also

Resource Pages
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Adding an Attachment Attribute to a Resource Type

Adding an Attachment Attribute to a
Resource Type

You can associate enterprise data dictionary attachments with the following ER/Studio Team
Server resource types: glossaries, terms, people, data sources, and the following ER objects:
tables, columns, logical entities, logical attributes, business entities and business attributes.

When you associate an attachment to a resource type, the Description subpage of the pages of
that type of resource include the associated attachment as a custom attribute which you can
edit from ER/Studio Team Server.

To associate an enterprise data dictionary attachment with a resource type:

1. Select My Settings > Admin > Managed Attributes.
2. Select the tab of the target type of resource. For example, Data Source.

3. On the left-hand side column, click an attachment to select it.

4. Click the ' icon to add the selected resource to the right-hand side column.

The selected attachment is now associated with the current resource type.

See Also

e Resource Pages
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Deleting a Resource

Deleting a Resource

You can delete a glossary, a term, or a data source as long as you are its original author (the
user who creates the resource), a stewards of the resource, or a super user.

To delete a resource of any of those types:

1. Open the page of the target resource. You can search for it.
2. On the resource page, click [Delete] on the header.
3. On the confirmation dialog box that opens, click OK.
The target resource is not available anymore in ER/Studio Team Server.

Note: Deleting a resource does not delete the resources that are related to it. For
example, if you delete a glossary, any term associated with it remains in ER/Studio

Team Server.

See Also

e Creating a Glossary

e CreatingaTerm

e Creating a Data Source
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Discussing Resources

Discussing Resources

ER/Studio Team Server lets you keep discussions with other ER/Studio Team Server users
about any resource (glossaries, terms, ER objects, and data sources).

You can access the discussions about a specific resource from the Discussions subpage of the
target resource page.

Topics

e Starting a Discussion about a Resource

See Also

e Following Resources

e Adding a Comment to an ER Object
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Starting a Discussion about a Resource

Starting a Discussion about a Resource

To start a discussion about a resource:

1. Open the page of that resource. You can try searching for it.

2. Openthe = Discussions subpage.

3. Click New Discussion on the top-right corner.

4. On the New Discussion dialog that opens:
1. Write the discussion title in the upper, one-line field.
2. Write your initial discussion message inside the multi-line text field.
3. Click Create to start the discussion.

Your new discussion topic is added to the list of topics in the Discussions page so that other
people can see it and join the discussion.

See Also

e Discussions page
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Editing a Resource

Editing a Resource

To edit a glossary, a term, or a data source:

1.

Open the page of the target resource. You can search for it.

2. Open the = Description subpage.

3. Click Edit to enter the edit mode. In edit mode, the Description page provides fields to
define the values of each property of the target resource.

4. Modify the resource properties.
For information about the fields that you can edit, check the documentation of the
description page of the type of resource that you are editing: glossary, term, or data
source.

5. To save your changes, click Save at the end of the page.
Note: To automatically update any matched items to the edited changes, the Auto
Match tick box on the Found In tab must be enabled.

See Also

Editing the Stewards of a Resource

Working with Glossaries

Working with Terms

Working with Data Sources
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Editing the Stewards of a Resource

Editing the Stewards of a Resource

To add or remove stewards from a resource:

1. Open the page of the target resource. You can search for it.

2. Open the = Description subpage.

3. Click Edit on the right-hand column, on the right-hand side of Stewards, to enter the
edit mode.

4. In edit mode, you can:

o Enter the name of a user into the text field and click Add to add that user to the
list of stewards.

o Click # on the right-hand side of an existing steward to remove that user from
the list of stewards.

5. To save your changes, click Done on the right-hand side of the Stewards header.

See Also

e Overview of Stewards

e Editing a Resource
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Following Resources

Following Resources

ER/Studio Team Server keeps track of people activity surrounding resources (glossaries, terms,
ER objects, and data sources). It records when someone edits a resource, posts a comment to a
resource, and so on.

You can follow a resource so that you can keep track of all the activity that surrounds that
resource. You can see the activity of every resource that you are following in your Home page.

Topics

e Following a Resource

e Posting a Comment to a Resource

e Unfollowing a Resource

See Also

e Discussing Resources

e \Watching ER Objects for New Comments

e Stream page

e Followers page
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Following a Resource

Following a Resource

To start following a resource:

1. Open the page of that resource. You can try searching for it.

2. Click + Follow on the upper-right corner of the resource page header.

You are now following the resource, and its activity is displayed in your Home page.

See Also

e Unfollowing a Resource
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Posting a Comment to a Resource

Posting a Comment to a Resource

You can post a comment to a ER/Studio Team Server resource (glossaries, terms, ER objects,
and data sources) so that people following that resource is notified, and anyone can read your

comment in the Stream subpage of the resource page.

To post a comment to a resource:

1. Open the page of that resource. You can try searching for it.

2. Open the "= Stream subpage.

3. Write your comment into the field with the text "Write a comment...", and click d
to send your comment.

ER/Studio Team Server adds your comment to the Stream page, and notifies any user following
the resource.

See Also

e Following a Resource

e Stream page
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Unfollowing a Resource

Unfollowing a Resource

To stop following a resource:

1. Open the page of that resource. You can try searching for it.

2. Click Following on the upper-right corner of the resource page header.

You are not following the resource anymore , and its activity is no longer displayed in your
Home page.

See Also

e Following a Resource
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Interacting with People

Interacting with People

You can interact with social users (people) as you interact with any other ER/Studio Team
Server resource. They have their own search page, resource page and subpages, and so on.

To see the details of a user, find it and open its person page.

Topics

e Searching for a User

e Following People

¢ Adding an Attachment Attribute to People

See Also

e People search page
e Person Pages
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Loading Glossaries and Terms from a CSV File

Loading Glossaries and Terms from a CSV
File

You can load into ER/Studio Team Server, glossaries and terms from CSV file if you have a CSV

file that follows the required format.

To load glossaries and terms from a CSV file:

1. Select Glossaries on the navigation menu.

2. Click Load Glossaries on the upper-right corner of the Glossaries page.

3. On the Load CSV File page that opens:
1. Click Browse and choose the target CSV file.

2. Click Load.

ER/Studio Team Server loads the glossaries and terms on the CSV file.

See Also

e Creating a Glossary

e CreatingaTerm
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CSV Format to Load Glossaries and Terms

CSV Format to Load Glossaries and Terms

ER/Studio Team Server can load CSV (comma-separated values) files containing information
about glossaries and terms as long as they follow the expected format.

Later in this topic are some examples of the format required to import either Glossaries or
Terms.

Each set of rows contains four or more rows with the following content:

The first row contains a fixed value, the start tag, which depends on the type of resource:
o If youwantto define a glossary: +++ Glossaries Begin +++.
o Ifyouwantto define aterm: +++ Terms Begin +++.

e The second row contains a comma-separated list of the names of properties of the
target type of resource that we want to define later. Only the resource name is
mandatory.

e Between the second row and the last row you can insert as many rows as you want. Each
one of the rows represents a single glossary or term, and contains a comma-separated
list of property values for that resource. The order that you have to use to specify the
resource property values is that of the property names in the second row.

e The last row contains a fixed value, the end tag, which depends on the type of resource:
o Ifyou defined a glossary: +++ Glossaries End +++.
o Ifyou defined aterm: +++ Terms End +++.

See also the examples of CSV files below.

Properties that You Can Use in Your CSV File

The property names that you can use on the second row of a set depends on whether your set
defines a glossary or a term.
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CSV Format to Load Glossaries and Terms

Glossary Properties

Item

Key

Name
(mandatory)

Status

Stewards

Definition
Abbreviations
Aliases
AdditionalNotes

ParentGlossary

[CustomAttributes]

Description
This value is filled when exporting existing glossaries and terms. Updating with the
key now allows you to modify the name without creating new ones. The Key field is

left empty when creating new glossaries.

Name of the glossary.

Chosen Status (this is a status of the glossary that is predefined by you).

List of usernames of ER/Studio Team Server users that must become stewards of
the new glossary.

Separate values with a semicolon. For example: usernamel; username?.
Definition of the new glossary.

An Abbreviation of the glossary.

An alias for the glossary.

Anything you would like to define in the Additional Notes section of your glossary.

Name of the parent glossary, in case you wish to structure your Glossary as a child
of another glossary.

Indicate the name of a custom attribute in the column header and value in a row. A
custom attribute should be assigned to glossaries in advance or it will be ignored.

Term Properties

Embarcadero Technologies 46


http://docwiki.embarcadero.com/TeamServer/ERStudio/en/Overview_of_Stewards

Item

Key

Name
(mandatory)

Status

Stewards

Definition
Abbreviations
Aliases
AdditionalNotes

RelatedGlossary

RelatedTerms

TermEntityType

[CustomAttributes]

CSV Format to Load Glossaries and Terms

Description
This value is filled when exporting existing glossaries and terms. Updating with the
key now allows you to modify the name and term type, without creating new ones.

The Key field is left empty when creating new terms.

Name of the term.

Chosen Status (this is a status of the term that is predefined by you).

List of usernames of ER/Studio Team Server users that must become stewards of
the new term.

Separate values with a semicolon. For example: usernamel; username?.
Definition of the new term.

An Abbreviation of the term.

An alias for the term.

Anything you would like to define in the Additional Notes section of your term.

Name of any related glossaries.

Separate values with a semicolon. For example: Glossaryl;Glossary?2.

Name of any related terms.

Separate values with a semicolon. For example: Terml; Term?2.

Name of the Term Entity Type. This can be predefined by you when creating terms,
or from the Term Entity Types subpage of the admin pages.

Indicate the name of a custom attribute in the column header and value in a row. A
custom attribute should be assigned to glossaries in advance or it will be ignored.

Custom Attributes

The custom attributes format depends on the type.
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CSV Format to Load Glossaries and Terms

Type Format Example
Date MM/DD/YYYY. 01/23/2013
Boolean True or False True
Time HH:MM:A 01:25 PM
Numeric Integer Number 364
External File Path |String \\servername\file.txt
Text String Some Text
Text List String and matching valid values |Value'

Examples of Valid CSV Files

These are some example CSV files that you can load into ER/Studio Team Server.

Single Glossary

The following CSV code defines a single glossary named "Accounting”.

+++ Glossaries Begin +++

Key,Name, Status,Definition,Abbreviations,Aliases, AdditionalNotes, Stewards,,,,,
,Accounting, Approve, "Glossary of commonly used accounting terms.",,,,admin,,,,,,,,
+++ Glossaries End +++

Terms

The following CSV code defines terms named "AMT" and "Abatement".

+++ Terms Begin +++

Key,Name, Status,Definition,Abbreviations,Aliases,AdditionalNotes, Stewards,RelatedGloss
aries,RelatedTerms, TermEntityType

,AMT, Approved, "Tax imposed to back up the regular income tax imposed on CORPORATION
and individuals to assure that taxpayers with economically measured income exceeding
certain thresholds pay at least some income tax.",,,,admin,Accounting,,

,Abatement, Approved, "Complete removal of an amount due, (usually referring to a tax
ABATEMENT a penalty abatement or an INTEREST abatement within a governing

agency) .",,,,admin, Accounting, AMT,

+++ Terms End +++

See Also

e Creating a Glossary

e Creatinga Term
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Searching for a Resource of a Specific Resource Type

Searching for a Resource of a Specific
Resource Type

To search for resources of a specific resource type (glossaries, terms, people, ER objects, or

data sources):

1. Select the search page of the target resource type: Glossaries, Terms, People, ER
Objects, or Data Sources.

2. Enter your search terms in the search field.

As soon as you stop typing, ER/Studio Team Server filters the list of resources and displays
only resources that meet your search criteria. Click their name to open their resource page.

See Also

e Search Pages
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Working with Glossaries

Working with Glossaries

Glossaries are collections of terms, such as "Human Resources"”, "Travel Department", or
"Customer Service". Glossaries can contain many terms, and each term can be associated with
many glossaries.

When you create a glossary or load them from a CSV file, you become its owner. Only you or a
super user can add terms to it or delete it.

To see the details of an existing glossary, find it and open its glossary page.

Topics

e Creating a Glossary

e lLoading Glossaries from a CSV File

e Searching for a Glossary

e Editing a Glossary

e Adding a Term to a Glossary

e Adding a Child to a Glossary

e Discussing Glossaries

e Following Glossaries

e Editing the Stewards of a Glossary

e Adding an Attachment Attribute to Glossaries

e Deleting a Glossary

e Glossary Tool Tips

See Also

o Glossaries search page

e Glossary Pages

e  Working with Terms
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Adding a Child to a Glossary

Adding a Child to a Glossary

To make an existing glossary a child of another glossary:

1. Open the page of the parent-to-be glossary. You can search for it.

2. Open the B children subpage.
3. Open the Manage tab.

4. In the list of existing glossaries, click Add Child on the right-hand side of a glossary to
add as a child of the current glossary.

Notes:

o You can use the search field at the top of the page to filter the list of existing
glossaries.

o You can click Remove Child on right-hand side of a glossary, on any of the tabs,
to remove the glossary from the list of children of the current glossary.

See Also

e Creating a Glossary

e Children subpage
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Adding a Term to a Glossary

Adding a Term to a Glossary

To add existing terms to a glossary:

1. Open the page of the target glossary. You can search for it.

2. Open the ETerms subpage.
3. Open the Relate tab.

4. In the list of existing terms, click Relate on the right-hand side of a term to add it to the
current glossary.

Notes:

o You can use the search field at the top of the page to filter the list of existing
terms.

o You can click Unrelate on right-hand side of a term, on any of the tabs, to
remove the term from the current glossary.

See Also

e CreatingaTerm

e Associating a Term with a Glossary

e Related Terms subpage
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Creating a Glossary

Creating a Glossary

To create a glossary:
1. Select Glossaries.
2. Click the New Glossary button on the upper-right corner.
3. Inthe New Glossary dialog box that opens:
1. Enter a Name to identify your new glossary.
2. Optionally, if you want your new glossary to be a child of an existing glossary:
1. Write in Parent Glossary the name of an existing glossary.

Tip: As you write the name of the parent glossary, a context menu appears listing
existing glossaries. You can click an item in the context menu instead of manually writing
the whole name of the parent glossary.

2. Click Add to set the parent.

Note: Click the # icon to the right-hand side of the parent name to unset the parent
glossary.

3. Define the Status of the glossary using nomenclature you decide upon. You can
use for example the following nomenclature: "Approved", "Not Yet Approved",
"Implemented"”, "Not Yet Implemented", and "Deprecated".

4. Write a Definition that provides detailed information about the glossary, such as
its purpose and audience.

5. Click Save to save your new glossary.

See Also

e Adding a Child to a Glossary

e Associating a Term with a Glossary

e Deleting a Resource

e New Glossary dialog box
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Glossary Tool Tip

Glossary Tool Tip

Glossary Tool Tips are links to your ER/Studio Team ServerGlossaries of matched words and
phrases in your browser. When you browse any web page that is in your list of configured sites,
matched Terms are automatically highlighted.

The page below is an example of a pop-up definition of the underlined Term.
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The underlined matches are Terms found in your ER/Studio Team Server installation. When
you hover your mouse over the underlined word, the pop-up box will show the first definition
found in your list of Terms. A link is provided to open your browser to your ER/Studio Team
Server pages of the related Term, where you can browse your company Glossaries for other
related Terms and ER Objects.

After your Glossary Tool Tips are enabled, browsing on any web page that has been configured
to be included will cross reference any matching Terms in your ER/Studio Team Server
installation.

@Note: Glossary Tool Tip is currently only available for Firefox web browser and requires
Greasemonkey Add-on.

@Note: You do not need to be signed in to ER/Studio Team Server to use Glossary Tool Tip,
however if your ER/Studio Team Server installation uses a secure HTTPS connection then the
ER/Studio Team Server's digital certificate must have previously been
accepted/imported/installed.

See Also

e Installing Glossary Tool Tips

o Glossaries

e Manage Glossary Tool Tips
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Installing Glossary Tool Tips

Installing Glossary Tool Tips

To enable Glossary Tool Tips on your browser:

1. Install the Firefox browser Greasemonkey Add-on.

2. Open Glossaries from the Navigation Menu and click the button.

Note: The link is also available by clicking Click here for more information at the
bottom of every page, including the initial page, prior to log on.

1. On the page that opens, click the button to install the

Greasemonkey script.

By default, the script has all web pages enabled. Your Administrator can include and exclude
various websites by editing the settings using the administration interface, see Manage Glossary

Tool Tips.
When you browse to an included page that has Terms matched to a Term in your Glossaries, it

will be underlined. Hover over the underlined Term with your mouse to show the definition or
click the popup to open in Connect.

See Also

e Manage Glossary Tool Tips

e Glossary Tool Tip

o Glossaries

e Terms
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Working with Terms

Working with Terms

Terms represent general concepts related to the business, such as "Social Security", "Tax ID",
"Zip Code", or "Call Resolution Time".

When you create a term, you become its owner. You can then associate your term with ER
objects, with glossaries, and with other terms. To see the details of an existing term, find it and

open its term page.

Topics

e CreatingaTerm

e lLoading Terms from a CSV File

e Searching fora Term

e EditingaTerm

e Associating a Term with a Glossary

e Associating a Term with Another Term

e Associating a Term with an ER Object

e Linked Terms

e Matching a Term with ER Objects

e Discussing Terms

e Following Terms

e Editing the Stewards of a Term

¢ Adding an Attachment Attribute to Terms

e DeletingaTerm

See Also

e Terms Search Page

e Term Pages
e Term API

e Working with Glossaries
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Associating a Term with a Glossary

Associating a Term with a Glossary

To associate a term with an existing glossary:

1. Open the page of the target term. You can search for it.

2. Open the BRelated Glossaries subpage.
3. Open the Relate tab.

4. In the list of existing glossaries, click Relate on the right-hand side of a glossary to
associate it with the current term.

Notes:

o You can use the search field at the top of the page to filter the list of existing
glossaries.

o You can click Unrelate on right-hand side of a glossary, on any of the tabs, to
disassociate the glossary with the current term.

See Also

e Creating a Glossary

e Adding a Term to a Glossary

e Related Glossaries subpage
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Associating a Term with an ER Object

Associating a Term with an ER Object

To associate an existing term with ER objects:

1.

Open the page of the target term. You can search for it.

2. Open the % Related ER Objects subpage.
3. Open the Relate tab. The tab contains a search page, similar to the ER Objects page.
4. Inthe list of ER objects, click Relate on the right-hand side of an ER object to associate
it with the current term.
Notes:
o You can use the search field at the top of the page to filter the list of existing ER
objects.
o You can click Unrelate on the right-hand side of an ER object to break its relation
with the current term.
See Also

Associating an ER Object with a Term

Related ER Objects subpage
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Associating a Term with Another Term

Associating a Term with Another Term

To associate an existing term with another existing term:

1. Open the page of one of the terms. You can search for it.

2. Open the ElRelated Terms subpage.
3. Open the Relate tab.

4. In the list of terms, click Relate on the right-hand side of a term to associate it with the
current term.

Notes:

o You can use the search field at the top of the page to filter the list of existing
terms.

o You can click Unrelate on the right-hand side of a term to break its relation with
the current term.

o As well as with relating terms, you may also group terms by Term Entity Type.
See the Creating a Term page on how to do this.

See Also

e CreatingaTerm

e Related Terms subpage
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Creating a Term

Creating a Term

To create a term:

1. Select Terms.
2. Click the New Term button on the upper-right corner.
3. Onthe New Term dialog box that opens:

1. Enter the Name of your new Term.

2. Define the Status of the Term using a nomenclature you decide upon. You can
use for example the following nomenclature: "Approved"”, "Not Yet Approved",
"Implemented"”, "Not Yet Implemented", or "Deprecated".

3. You are also able to choose a Term Entity Type. You can also choose your own
nomenclature. For example, Entity Term Type could provide a way to distinguish
between different types of Terms. This makes it easier for you to see the
relationship and understand the distinction. It also allows for Terms with the
same name but different type. Examples of types might include the Subject Area,
Documents, Reports or Domains.

4. Optionally, if you want to add your new Term to existing glossaries, for each one
of those glossaries:

1. Write in the Related Glossaries text field the name of the glossary.

Tip: As you write the name of the glossary, a context menu appears listing existing
glossaries. You can click an item in the context menu instead of manually writing the
whole name of the glossary.

2. Click Add to include the glossaries in the list of related glossaries.

Note: Click the #icon to the right-hand side of a glossary in the list under Related
Glossaries to remove the glossary from the list of related glossaries.

5. Write a Description that provides detailed information about the Term, such as
its purpose and audience.

6. Click Save to save your new Term.

See Also

e Adding a Term to a Glossary

e Associating a Term with Another Term

e Deleting a Resource

e Glossaries search page
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Linked Terms

Linked Terms

Linked Terms allow you to implement Terms in your Glossaries much faster and make use of
taxonomies already in use.

A Linked Term is a term associated to an ER Object, taking the name and description from it.
Linked Terms are automatically created when a Domain, Model or Submodel ER Object is
synchronized. Their properties are populated from the ER Object.

It is possible to create Linked Terms by clicking the option in the header of the ER Object.

@Note: Linked Terms can be exported but cannot be imported since they only exist when
linked to an object.

See Also

e CreatingaTerm

e Related Terms subpage

Embarcadero Technologies 61


http://docwiki.embarcadero.com/TeamServer/ERStudio/en/Related_Terms

Matching a Term with ER Objects

Matching a Term with ER Objects

ER/Studio Team Server lets you associate any term with ER objects that contain the target

term.

To match an existing term with ER objects:

1.

2.
3.
4.

Open the page of the target term. You can search for it.

Open the %wRelated ER Objects subpage.

Open the Found In tab. The tab contains a search page, similar to the ER Objects page.
Click Refresh.

ER/Studio Team Server finds any ER object that contains the current term in its name or
description, and adds it to the Found In tab. You can also see matched ER objects in the View
tab, listed after related ER objects.

In the Found In tab, you can click the Unmatch button. This will remove the matching of the ER
object and it will no longer be listed under the View tab. The Re-Match button will match ER
objects that you manually unmatched.

Clearing the Auto Match tick box will disable the Auto Match function and any items that you
Unmatch will be saved.

See Also

Matching an ER Object with Terms

Related ER Objects subpage
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Working with Data Sources

Working with Data Sources

Data sources are sets of data that define how to establish a connection to a specific database.

Topics

Creating a Data Source

Data Source Fields for a Specific Database Management System

Searching for a Data Source

Editing a Data Source

Associating a Data Source with an ER Model

Associating a Data Source with a Login Credential

Monitoring a Data Source

Discussing Data Sources

Following Data Sources

Editing the Stewards of a Data Source

Adding an Attachment Attribute to Data Sources

Deleting a Data Source

See Also

Data Sources search page

Data Source Pages

Login Credentials
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Associating a Data Source with an ER Model

Associating a Data Source with an ER
Model

To associate a Data Source with an ER Model:

1. Open the ER Objects page from the Navigation bar. In the left Navigation Bar, filter by
Models.

2. Click on the Model that you would like to associate with the Data Source.

3. Open the = Related Data Sources subpage.

4. Open the Relate tab. The tab contains a search page, similar to the ER Objects page.

5. Inthe list of Data Sources, click Relate on the right side of a Data Source to associate it
with the current ER Model.

Notes:

o You can use the search field at the top of the subpage to filter the list of existing
Data Sources.

o You can click Unrelate on the right side of a Data Source to break its relation
with the current ER Model.

See Also

e Creating a Data Source

o Data Sources search page
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Associating a Data Source with a Login Credential

Associating a Data Source with a Login
Credential

The Related Data Sources subpage of Login Credentials lists the Data Sources that are either
related to the current Login Credential, or that can be related to the Login Credential.

You can use the Related Data Sources page to relate or unrelate Data Sources to the current
Login Credential.

The page is divided in two tabs:
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View Tab

The View Tab displays a list of related Data Sources. The list shows the Data Sources currently
related to the selected Login Credential.
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Relate Tab

The Relate Tab allows you to relate and unrelate Data Sources to the current Login Credential.

The Relate tab contains a list of Data Sources that can be related to the Login Credential. The
list is arranged with alphabetical navigation and contains a search box.

On the right side of the Data Sources entries, you can click Relate to relate a Data Source to the

current Login Credential, or you can click Unrelate to unrelate the target Data Sources from the
current Login Credential.

See Also

e Data Source Pages

e Login Credential Pages
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Associating a Data Source with a Login Credential

e Working with Login Credentials
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Creating a Data Source

Creating a Data Source

To create a data source:

1. Select Data Sources.

2. Click the New Data Source button on the upper-right corner.

3. Onthe
1.

6.

See Also

New Data Source dialog box that opens:

Enter a Name for your new data source. Names of data sources in ER/Studio
Team Server must be unique.

Select from the Type combo box the database management system (DBMS) that
stores the database.

Fill the fields after the Type field and before the Custom Properties field. These
fields change depending on the selected DBMS Type. See Data Source Fields
for a Specific Database Management System.

Optionally, under Custom Properties, you can define custom properties for the
data source. For each property:

1. Enter the Name of the property.
2. Enter the Value for the property.

3. Click Add to add the defined property-value pair to the list of properties
of the data source.

Write a Description that provides detailed information about the data source,
such as its purpose and audience.

Click Save to save your new data source.

e Deleting a Resource

e New Data Source dialog box
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Data Source Fields for a Specific Database Management System

Data Source Fields for a Specific Database
Management System

The following tables provide details about the data source fields that are specific to a database
management system: DB2 LUW, DB2 z/OS, InterBase, Firebird, JDBC, MySQL, ODBC, Oracle,

SQL Azure, SQL Server, Sybase, Sybase 1Q.

You can access these fields when you create a data source or when you access the description
page of an existing data source.
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DB2 LUW

Item

Use DB2 client
aliases

Host Name

Port

Remote DB Name
Schema ID
Functional Path

OS Authentication

DB2 z/OS

Item

Use DB2 client
aliases

Host Name

Port

Remote DB Name
Schema ID
Functional Path

OS Authentication

InterBase

Embarcadero Technologies

Data Source Fields for a Specific Database Management System

Description

Check Enable to allow using DB2 client aliases.

IP address or host name of the database server.
Network port where the database server is listening.
Name of the target database.

|dentifier of the target schema.

The functional path.

Check Enable to log in to the database with the credentials of a user of the
operating system where DB2 LUW is running.

Description

Check Enable to allow using DB2 client aliases.

IP address or host name of the database server.
Network port where the database server is listening.
Name of the target database.

Identifier of the target schema.

The functional path.

Check Enable to log in to the database with the credentials of a user of the
operating system where DB2 z/OS is running.
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Data Source Fields for a Specific Database Management System

ltem Description
Host Name IP address or host name of the database server.
Port Network port where the database server is listening.
Character Set Character set of the database.
Dialect Dialect of the database.
Role Role to access the database.

Database file path |Path to the database file.

Firebird

ltem Description
Host Name IP address or host name of the database server.
Port Network port where the database server is listening.
Character Set Character set of the database.
Dialect Dialect of the database.
Role Role to access the database.

Database file path |Path to the database file.

JDBC

[tem Description

Connection URL |URL to connect to the database.

MySQL

Embarcadero Technologies
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Data Source Fields for a Specific Database Management System

[tem Description
Host Name IP address or host name of the database server.
Port Network port where the database server is listening.
Default Database Name of the target database.
Windows Check Enable to use native Windows authentication to connect to the target
Authentication database.

ODBC

Item Description

Use DSN Check Enable to use DSN to connect to the target database.

Connection String |String that defined how to connect to the target database.

Oracle

There are four different ways you can connect to an Oracle database. Use the Use combo box
to select the system you want to use: Alias, Connect Descriptor, SID, Service Name.
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Data Source Fields for a Specific Database Management System

Connecting to Oracle with Alias

Item

TNSNames.ora Alias

Instance Name

Role

Windows
Authentication

Description
Alias to connect to the database.
Name of the database instance.
Role to connect to the database.

Check Enable to use native Windows authentication to connect to the target
database.

Connecting to Oracle with Connect Descriptor

Item

Connect Descriptor
Instance Name
Role

Windows
Authentication

Description
Description of the connection to the database.
Name of the database instance.
Role to connect to the database.

Check Enable to use native Windows authentication to connect to the target
database.

Connecting to Oracle with SID

[tem
Host Name
SID
Port

Instance Name

Role

Windows
Authentication

Description
IP address or host name of the database server.
Oracle system identifier that uniquely identifies the target database.
Network port where the database server is listening.
Name of the database instance.
Role to connect to the database.

Check Enable to use native Windows authentication to connect to the target
database.

Connecting to Oracle with Service Name
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Item

Host Name

Service Name

Port

Instance Name

Role

Windows
Authentication

SQL Azure

Item

Host Name

Data Source Fields for a Specific Database Management System

Description
IP address or host name of the database server.
Service name that identifies the target database.
Network port where the database server is listening.
Name of the database instance.
Role to connect to the database.

Check Enable to use native Windows authentication to connect to the target
database.

Description

IP address or host name of the database server.

Default Database [Name of the target database.

SQL Server

Item

Host Name
Port

Protocol

Encryption
Default Database
Packet Size

Windows
Authentication

Sybase

Description

IP address or host name of the database server.
Network port where the database server is listening.

Protocol to use for the network connection. You can choose any of the
following options:

e TCP/IP (default). Standard network protocol.
e Name Pipes. Windows-specific network protocol.

Check Enable to encrypt the network communication.
Name of the target database.
Size of the network packets.

Check Enable to use native Windows authentication to connect to the target
database.
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Item

Use Sybase SQL.INI

aliases

Host Name

Port

Encryption
Default Database
Packet Size

Max Connections
Character Set

Kerberos
Authentication

Sybase 1Q

Item

Host Name
Port
Database

Windows
Authentication

See Also

Data Source Fields for a Specific Database Management System

Description

Check Enable to use Sybase SQL.INI aliases.

IP address or host name of the database server.

Network port where the database server is listening.
Check Enable to encrypt the network communication.
Name of the target database.

Size of the network packets.

Maximum number of connections that can be established.
Character set of the database.

Check Enable to use the Kerberos network authentication protocol to connect
to the target database.

Description
IP address or host name of the database server.
Network port where the database server is listening.
Name of the target database.

Check Enable to use native Windows authentication to connect to the target
database.

e Creating a Data Source

o Data Source Description page
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Working with Login Credentials

Login Credentials are security containers that store and manage passwords for accessible Data
Sources from ER/Studio Team Server. Login Credentials contain an alias that identifies the
credential for sharing.

Only users with Update/Delete permission on Data Sources are able to edit Login Credentials.
Any password changes are invisible for common users.

To see the details of an Login Credentials, browse to it and open the corresponding Login
Credential page.

Topics

e Creating Login Credentials

e Editing Login Credentials

e Deleting Login Credentials

e Browsing Login Credentials

e Associating a Login Credential with a Data Source

See Also

e Login Credential Pages

e Login Credentials Search Page

e Data Sources
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Creating Login Credentials

Creating Login Credentials

To create a Login Credentials:

1.

Select the Data Sources search page and then select Login Credentials on the left-hand

sidebar.

2. Click the New Login Credentials button on the upper-right corner.
3. Onthe New Login Credentials dialog box that opens:
1. Define the Name of your new Login Credential.
2. Type the User Name. User Name is a login for a Data Source.
3. Enter and confirm the Password. Password that allows access to the Data Source.
For systems that may not require a password such as Sybase, this field may be left
empty.
4. Write a Description that provides detailed information about the Login
Credential, such as its purpose and users group.
5. Click Save to save your new Login Credential.
See Also

Associating a Login Credential with a Data Source

Deleting Login Credential

Login Credentials Search page
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Editing a Resource

Editing a Resource

To edit a glossary, a term, or a data source:

1.

Open the page of the target resource. You can search for it.

2. Open the = Description subpage.

3. Click Edit to enter the edit mode. In edit mode, the Description page provides fields to
define the values of each property of the target resource.

4. Modify the resource properties.
For information about the fields that you can edit, check the documentation of the
description page of the type of resource that you are editing: glossary, term, or data
source.

5. To save your changes, click Save at the end of the page.
Note: To automatically update any matched items to the edited changes, the Auto
Match tick box on the Found In tab must be enabled.

See Also

Editing the Stewards of a Resource

Working with Glossaries

Working with Terms

Working with Data Sources
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Deleting Login Credentials

You can delete a Login Credential if you have proper permissions or if you are a super user.

To delete a Login Credentials from ER/Studio Team Server:

1. Open the page of the target Login Credential. You can search for it.

2. On the Login Credential page, click [Delete] on the header.

3. On the confirmation dialog box that opens, click OK.
The target Login Credential is not available anymore in ER/Studio Team Server.

Note: Deleting a Login Credential does not delete the Data Source associated with it.

See Also

e Creating Login Credentials

o Related Login Credentials
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Browsing Login Credentials

Browsing Login Credentials

To search for Login Credentials:

1. Select the Data Sources search page and then select Login Credentials on the left-hand
sidebar.

2. Enter your search Login Credentials in the search field.

As soon as you stop typing, ER/Studio Team Server filters the list of Login Credentials and
displays only the ones that meet your search criteria. Click their name to open their resource

page.

See Also

e Search Pages
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Related Login Credentials

Related Login Credentials
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The Related Login Credentials subpage of Data Sources lists the Login Credentials that are
either related to the current Data Source, or that can be related to the Data Source.

You can use the Related Login Credentials page to relate or unrelate Login Credentials to the
current Data Source.

The page is divided in two tabs:

View Tab

The View Tab displays a list of related Login Credentials. The list shows the Login Credentials

currently related to the selected Data Source. From here you can test connection to the current
Data Source with each related Login Credential .

— e =] ]
s — e
—

Relate Tab

The Relate Tab allows you to relate and unrelate Login Credentials to the current Data Source.

The Relate tab contains a list of Login Credentials that can be related to the Data Source. The
list is arranged with alphabetical navigation and contains a search box.

On the right side of the Login Credentials entries, you can click Relate to relate a Login

Credential to the current Data Source, or you can click Unrelate to unrelate the target Login
Credential from the current Data Source.

See Also

e Data Source Pages

e Login Credential Pages
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¢ Working with Data Sources

Related Login Credentials
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Login Credential Pages

Login Credential Pages

Login Credential pages provide information about them: Description and Related Data Sources.

To open a Login Credential page, follow a Login Credential link. If you are looking for a specific
Login Credential, you can use the Login Credentials Search page .

Login Credentials pages share a common header, and they also share a common sidebar. When
you click the items in the sidebar, you get access to information pages about different aspects
of the target Login Credential.

Login Credentials Pages Header

Sales Representative

Lagin Credentials

The Login Credential header shows:
e The Login Credential icon.
e The name of the Login Credential.
e The type of resource ("Login Credentials").

e If you have proper permissions or if you are a super user, you can click [Delete] to delete
the Login Credential.

Login Credentials Pages Sidebar

Login Credentials pages provide a sidebar with the following items:

[tem Description

Provides detailed information about the Login Credential.
Description

Shows a list of data sources that are associated with the current Login Credential

Related Data
Sources

Opens the users and groups permissions tab for the login credential.
Permissions

See Also

e Working with Login Credentials
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Access Control Permissions

Access Control Permissions

Permisslons

bo b bo be

ER/Studio Team Server gives administrative permissions to users with the Super User role by
default. Users assigned to the Super User role in ER/Studio can assign permissions to other
users in ER/Studio Team Server and limit the actions that specific users or groups of users can
perform over a resource from the Access Control List page.

The page is divided in two tabs, which are described below.

Users Tab

The Users Tab displays a list of users available to assign permissions. To manage the
permissions of each user, click the Edit button.

Parmlssinne
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Groups Tab
The Groups Tab displays a list of groups available to assign permissions. It allows you to:

e Create a New Group.

e Mark a group as default. If you click the Mark as default group button, ER/Studio Team
Server will assign this default group to each new user. To clear a group as default, you
can click the Unmark as default group button.

¢ Manage permissions for groups.

e Delete a group.

Topics

¢ Manage User Permissions on a Resource

e Manage Group Permissions on a Resource

e Manage Permissions for Individual Resources
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Access Control Permissions

e Creating a Permissions Group

e Deleting a Permissions Group

See Also

e Manage Users

e Working with Resources

e Working with Login Credentials
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Manage User Permissions on a Resource

Manage User Permissions on a Resource

To manage User Permissions:
1. Select Permissions page and then select Users tab.
2. Click the Edit button on the upper-right corner.
The Manage User Permissions page shows a permissions table where you can set specific

permissions for Glossaries, Terms, ER Objects, Datasources, and Login Credendials.

Permissbons
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It shows the following options for each element type:

[tem Description
List/View Check this option to allow only read permissions.
Create Check this option to allow creating the resources.

Update/Delete |Check this option to allow editing and deleting the resources.

Stewards Check this option to allow user to manage the Stewards of a resource.

The Groups Membership table allows you to include the user on permissions groups.

Click the Save button to save your settings.

See Also

e Admin

e Manage Group Permissions on a Resource
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Manage User Permissions on a Resource

Deleting a Permissions Group
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Manage Group Permissions on a Resource

Manage Group Permissions on a Resource

To manage Groups Permissions:
1. Select Permissions page and then select Groups tab.
2. Click the Edit button on the upper-right corner.

The Manage Groups Permissions page shows a permissions table where you can set specific
permissions for Glossaries, Terms, ER Objects, Datasources, and Login Credentials.

Permissions
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It shows the following options for each element type:

[tem Description
List/View Check this option to allow only read permissions.
Create Check this option to allow creating the resources.

Update/Delete |Check this option to allow editing and deleting the resources.

Stewards Check this option to allow user to manage the Stewards of a resource.

The Members table allows you to include the user on permissions groups.

You can also modify the name and the description of the group on this page.
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Manage Group Permissions on a Resource

Click Save button to save your settings.

See Also

e Admin

e Manage User Permissions on a Resource

e Deleting a Permissions Group
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Creating a Permissions Group

Creating a Permissions Group

To create a Permissions Group:
1. Select Access Control List page and then select Groups tab.
2. Click the New Group button on the upper-right corner.
3. On the New Group dialog box that opens:
1. Define the Name of your new permissions group.

2. Write a Description that provides detailed information about the group, such as
its purpose and privileges.

3. Click Save to save your new permissions group.

See Also

¢ Admin

e Manage Group Permissions on a Resource

e Deleting a Permissions Group
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Deleting a Permissions Group

Deleting a Permissions Group

To delete a Permissions Groups from ER/Studio Team Server:
1. Select Access Control List page and then select Groups tab.
2. Click the Delete button on the right-hand side of the groups entries.
3. On the confirmation dialog box that opens, click OK.

The target group is not available anymore in ER/Studio Team Server.

Note: Deleting a Permissions Group does not delete any users belonging to it.

See Also

¢ Admin

e Creating a Permissions Group

e Manage Group Permissions on a Resource
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Monitoring

The Data Sources Monitoring tab allows you to turn on Data Source metric alerts.
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The monitored metrics are:
¢ Host Ping Time
e SQL Statements Executed
e Processor Count
e Percentage Space Used
e Query Response Time
e Space Used
e DB Ping Time
¢ Logins
e Percentage Space Available
e Space Available
e Online/Offline availability.

@Note: To set up Monitoring, you will need to have a set of login credentials configured for
your data source. You must also use the test connection button to initialize the link which will
verify the connectivity.

Click Start for the login credential you tested previously to start recording metrics.

Then you can view the data source metrics in the data source description.
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Monitoring

See Also

e Working with Login Credentials

e Working with Data Sources

e Data Source Alerts

e Maintenance Window
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Maintenance Window

Maintenance Window

The Data Sources Maintenance Window tab allows you to turn off Data Source metric alerts for
a period of time.

To stop false alerts being generated when you are making changes or rebooting your data
sources, the Maintenance Window allows you to set up a time period during which the
configured Alerts will not be triggered.

Setup Maintenance Window Alerts

During the Maintenance Window, Team Server will not attempt to capture information from the Data Source.
Maintenance Window is currently: enabled.

Current Date & Time: July 17, 2014 13:43:30 PM

& One Time Stop Monitoring on: IU?f17f2014
€ Daily
& Weekly

Stop Menitoring at: 13:40 for 5 minutes

Combie | sove

See Also

o Working with Data Sources

e Data Source Alerts
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Data Source Alerts

Data Source Alerts

The Data Sources Alerts tab allows you to configure Data Source metric alerts.

Clicking the Configure button allows you to modify and set the alert status to on or off.

Clicking the escalation check box allows you to configure the alert to escalate to high when the
escalation variable is reached.

Setup

Maintenance Window ‘ Alerts ‘

Status  Alert Name

Alert Description

Cores/CPUs

DB Ping Time (ms)

Host Ping Time (ms)

Logins (Sessions Created)

Online

Query Response Time (ms)

SQL Statements Executed

Space Free (%)

Space Free (MBE)

Space Used (%)

Space Used (MB)

Trigger it when the value has changed

DB Ping Time threshold is 1500 ms

Host Ping Time threshold is 500 ms

Logins thresholds is 0

Trigger it when the Data Source is Offline

Query Response Time threshold is 500 ms

SQL Statements Executed threshold is 0

Space Free threshold is 16%

Space Free threshold is 0 MB

Space Used threshold is 84%

Space Used threshold is 0 MB

e )
=8
=8
=8
=8
=8
=8
=8
=8
=8
=8

The alerts are posted to your stream and if you have email notifications configured, they will
also be sent to your configured email address.

See Also

e Working with Data Sources

e Maintenance Window
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Working with ER Objects

Working with ER Objects

ER objects are objects from ER/Studio Repository that you can access from ER/Studio Team
Server.

To see the details of an ER object, find it and open its ER object page. To find an ER object, you
can:

e Browse your ER objects using the Model Explorer page.

e Use the simple search.

e Use the advanced search.

Topics

e Browsing ER Objects

e Searching for an ER Object

e Using the Advanced Search of ER Objects

e Associating an ER Object with a Term

e Matching an ER Object with Terms

e Discussing ER Objects

e Following ER Objects

e Adding an Attachment Attribute to ER Objects

e Configuring Sensitive Data Alerts

e Working with ER Object Comments

o Working with ER Object Labels

See Also

e Synchronizing with ER/Studio Repository

e Working with ER Object Comments

e Working with ER Obiject Labels

e ER Obijects Search Page

e ER Object Pages

e Linked Terms
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Associating an ER Object with a Term

Associating an ER Object with a Term

To associate an ER object with an existing term:

1.

Open the page of the target ER object. You can search for it.

2. Open the ElRelated Terms subpage.
3. Open the Relate tab. The tab contains a search page, similar to the Terms page.
4. In the list of terms, click Relate on the right-hand side of a term to associate it with the
current ER object.
Notes:
o You can use the search field at the top of the page to filter the list of existing
terms.
o You can click Unrelate on the right-hand side of a term to break its relation with
the current ER object.
See Also

Linked Terms

Associating a Term with an ER Object

Related Terms subpage
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Browsing ER Objects

Browsing ER Objects
Model Explorer

Bl localhost

iE Projects

L
1

3| lwventure

= Enterprise Dictionaries

B wo rkspaces

You can browse the hierarchy of ER objects from the Model Explorer page.

In this hierarchy, you can expand every ER object too see its content, and you can click any ER
object to access its description page, which contain links that you can use to continue browsing
your ER objects.

As you hover over certain ER objects, such as diagrams, ER/Studio Team Server displays pop-up
windows with detailed information about the ER object. Hovering over the name of an ER
object with an eye icon, such as a model or a submodel, displays a miniature picture of the ER

object.

See Also

Searching for a Resource of a Specific Resource Type

Working with ER Object Comments

Working with ER Object Labels

ER Object Pages

Overview of Data Synchronization
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Configuring Sensitive Data Alerts

Configuring Sensitive Data Alerts
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@( ustomer information

Header of an ER object that matches two alert conditions.

You can configure security properties and attachments so that ER/Studio Team Server displays
custom alerts on the header of the pages of ER objects bound to those security properties and
attachments, or that have a specific value for those.

This feature lets you warn about sensitive data. For example, you can show a message on any
ER object bound to a certain security property with a value of "High", and describe in the alert
the risks of not keeping the ER object information confidential.

To configure these sensitive data alerts, you must define alert conditions using the Alerts page
of the target security property or attachment.

Topics

e Adding a Sensitive Data Alert Condition

e Editing a Sensitive Data Alert Condition

e Deleting a Sensitive Data Alert Condition

See Also
e Alerts subpage

e Object Alerts page
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Adding a Sensitive Data Alert Condition

Adding a Sensitive Data Alert Condition

To add a sensitive data alert condition to a security property or attachment:

1.

Open the page of the target ER object. You can search for it.

Open the "FAlerts subpage.
Click Add New Condition to add a new alert condition resource to the page.

On the new alert condition resource:

On the Show Alert for Matching field, select one of the following values:

= Bound Object if you want the alert condition to affect any ER object
bound to the current security property or attachment.

= Value if you want the alert condition to affect any ER object bound to the
current security property or attachment with a specific value. Enter the
target value into the input field on the right-hand side.

Select an Alert Level, either Notice or Info. The alert level determines the icon
that ER/Studio Team Server shows along with the Notification Text.

Enter into Notification Text the text of the notification.

From the Notification Text field, press S to take the focus out of the field.
ER/Studio Team Server saves field values as you take the focus out of them.

Your alert condition is now in effect. You can edit it later or delete it.

See Also

Editing a Sensitive Data Alert Condition

Deleting a Sensitive Data Alert Condition

Alerts subpage
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Deleting a Sensitive Data Alert Condition

Deleting a Sensitive Data Alert Condition

There are two methods of deleting an existing sensitive data alert condition:
Option 1:

1. Open the page of the security property or attachment that contains the alert condition.
You can search for it.

2. Open the "FAlerts subpage.
3. Click Delete Condition on the target alert condition resource.
Option 2:
1. Go to My Settings > Admin > Object Alerts (super users).
2. On the right of the condition you want to delete, click the blue Delete button.
3. Click OK on the deletion warning popup.

While super users can delete any alert condition, authenticated users can only delete the alert
conditions that they create.

See Also

e Adding a Sensitive Data Alert Condition

e Editing a Sensitive Data Alert Condition

e Alerts subpage
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Editing a Sensitive Data Alert Condition

Editing a Sensitive Data Alert Condition

To edit an existing sensitive data alert condition:

1. Open the page of the security property or attachment that contains the alert condition.
You can search for it.

2. Open the "FAlerts subpage.
3. Locate and modify the target alert condition resource.

ER/Studio Team Server saves text input field values as you take the focus out of them. After
you change a text value, press S or change another option so that ER/Studio Team
Server saves your changes.

Alternatively, if you are a super user, you can edit any existing alert condition from the Object
Alerts page.

See Also

e Adding a Sensitive Data Alert Condition

e Deleting a Sensitive Data Alert Condition

e Alerts subpage

e Object Alerts page
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Matching an ER Object with Terms

Matching an ER Object with Terms

ER/Studio Team Server lets you associate any ER object with terms that contain the target ER
object.

To match an existing ER object with terms:

1. Open the page of the target ER object. You can search for it.

2. Open the ElRelated Terms subpage.

3. Open the Match tab. The tab contains a search page, similar to the Terms page.
4. Click Refresh.

ER/Studio Team Server finds any term that is present in the name or the description of the
current ER object, and adds it to the Match tab. You can also see matched terms in the View
tab, listed after related terms.

In the Match tab, on the right-hand side of the term entries, you can click Unmatch to unmatch
matched terms, or click Re-Match to match terms that you manually unmatched.

See Also

e Matching a Term with ER Objects

e Related Terms subpage
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Using the Advanced Search of ER Objects

Using the Advanced Search of ER Objects

Using the advanced search you have more control of the search than with any other search box
in ER/Studio Team Server.

Using the advanced search, you can:

e Specify that the property value starts with, contains, ends with, or is an exact match to
the text.

e Set filters to include or exclude results based on modification dates and specific ER
object types.

e Set how you want the search results sorted.

e Specify the number of results to display per page.

Topics

e Searching for an ER Object Using the Advanced Search

e Saving Favorite Searches

¢ Sending Searches By Email

e \Writing an Advanced Search String

See Also

e Advanced Search page
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Searching for an ER Object Using the Advanced Search

Searching for an ER Object Using the
Advanced Search

To perform an advanced search:

1. Open the Advanced Search page.

2. In the Search Text field, enter a valid search string.

3. Check "Include matches for similar-sounding words" to search for text that sounds like
the search text.

4. In the Filters field, select any of the available options:
o All. Search for any ER object.
o Data. Search only for ER/Studio Data Architect objects.
o Business. Search only for ER/Studio Business Architect objects.

5. In the Modification area, you can define a specific period of time and user. The search
results only contain ER objects modified by the specified user during the specified
period of time.

1. In the Modified field, select a period of time. Select "anytime" not to restrict
results by their last modification date.

2. Inthe By field, enter the name of a user. Leave the field empty not to restrict the
results to those modified by a specific user.

6. Inthe Object Type area, you can select the ER object types that you want to include in
the search. To select multiple items in the list, hold the ctrl key and click the target
items. To not filter by ER object type, check the All option.

7. Inthe Property area, you can define pairs of properties and values that must match in
the search results. To add a property-value pair to filter the search results:

0. Inthe Name field:

1. Click the ellipsis button. ER/Studio Team Server displays a list of
properties.

2. Select the target object type in the Highlight properties for combo box.
3. Click the target property from the list of properties.

1. In the Value field, enter a valid value for the selected property. This will limit the
search results to ER objects where the selected property has this value.

2. Optionally, click ¥ on the left-hand side of the Name and Value fields to indicate
that this is an mandatory inclusion search criteria.

Notes:
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Searching for an ER Object Using the Advanced Search

= If you do not click +"the search string is considered optional, and not required for
a match.

= Click @to exclude the specified property-value pair from the search results.

If you need additional property-value fields, click the % button on the right-hand side of
the first set of Name and Value fields.

8. In the Sorting combo box, you can select a field to sort the search results.
9. In the Pagination combo box, you can select the number of results to show per page.

10. Click Search. The Advanced Search page reloads to show the search results.

The results of the advanced search are displayed by default in HTML format. To view the results
in table format, click View as table at the top left-hand side of the results results page.

At the bottom of the search results page you can specify a different search criteria, and search
again to further refine your search.

See Also

e \Writing an Advanced Search String

e Saving Favorite Searches

e Advanced Search
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Saving Favorite Searches

Saving Favorite Searches

After completing and running an advanced search, you can name and save the search for later
use.

To save an advanced search as favorite:

1. Perform an advanced search.

2. After ER/Studio Team Server loads the search results, click the “icon in the results
header.

3. On the Add to favorite dialog box that opens:
1. Enter a descriptive Name for your search.

2. Optionally, write a Description that provides additional details that would not fit
the search name.

3. Optionally, check the Shared checkbox to make your new favorite search public,
so that any other user can access your search from the Favorite Searches page. If
you leave this option unchecked, only you can access your new favorite search
from the Favorite Searches page.

After you save your new advanced search as favorite, you can find it in the Favorite Searches
page. If you are a non-social user, you can find your favorite searches in the Home page as well.

In addition to the search text, saved searches include the ordering and filter settings.

See Also

e Using the Advanced Search of ER Obijects

e Favorite Searches page

e Search Results page

e Home (non-social) page
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Sending Searches By Email

Sending Searches By Email

If emailing search results is enabled, follow these steps to send an advanced search for ER
objects by email:

1. Perform the advanced search.

2. On the results page, click =,
3. On the Email Search Results dialog box that opens:
1. Specify in To an email address of the recipient.

2. Use the Rows combo box to choose the maximum number of results that the
message should include.

3. Click Submit to send the message.

See Also

e Using the Advanced Search of ER Obijects
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Writing an Advanced Search String

Search strings in ER/Studio Team Server:

e Are not case-sensitive. For example, you get the same results when you search for good,
Good or gOOd.

e Support quoting text to match exact phrases. For example, "good idea" matches good
idea, but not idea good or good or bad idea.

e Support logic operators: OR, AND.

e Support making mandatory or excluding words.

e Support wildcard characters: *, ?.

e Support the similarity and proximity character: ~.

To use special characters as normal characters, such as using * as an asterisk and not as a
wildcard character, see Escaping Special Characters.

Using Logic Operators

You can use OR or AND in your search strings:

e OR matches if there is a match for any of the expressions at each side of the OR
keyword. For example, searching for good OR idea returns the combination of the
results of searching for good and the results of searching for idea: good, idea, good
idea.

e AND matches if there is a match for both expressions at each side of the AND keyword.
For example, searching for good AND idea returns only the results that are among both
the results of searching for good and the results of searching for idea: good idea, but
not good or idea.

Making Mandatory or Excluding Words

By default, a match for a word is optional. The + and - symbols, used at the beginning of a
word, change that:

e+ makes the word mandatory. For example, +apples oranges matches apples and
oranges, apples, but not oranges.

e - excludes the word. For example, -apples oranges matches oranges, but not apples or
apples and oranges.

Using Wildcard Characters

When searching ER/Studio Team Server, you can use the asterisk (*) and the question mark (?)
wildcard characters. This is how they work:
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Writing an Advanced Search String

e *represents O or more characters. For example, t*s matches tsunami, test or this.

e ?represents a single character. For example, a?h matches agh or athletic, but not ah or
argh.

Note: The first character in a search string cannot be a wilcard character.

Using the Similarity and Proximity Character

Using ~ at the end of a word matches similar words as well. For example, land~ matches land,
sand and band.

Using ~ at the end of a quoted string, followed by a positive integer, matches results where the
words within the string are within the specified number of words of each other. For example,
"diagram update" ~10 matches ER objects where diagram and update appear within 10 words
of each other.

Escaping Special Characters

ER/Studio Team Server search features are powered by Apache Solr. There are some special
characters that you must escape within a search string to use them as normal characters: + - &&

NPOIA"~*2:\

To use a special character as a normal character in a search string, you must escape the special
character. To escape a special character, write a backslash (\) before the wildcard character in
the search string. For example, searching for ABC\*DEF\?GHI matches the literal term
ABC*DEF?GHI.

See Also

e Search Pages
e Using the Advanced Search of ER Obijects

e Advanced Search
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Working with ER Object Comments

Working with ER Object Comments

ER/Studio Team Server lets you access the comments that ER/Studio Repository users leave in
ER objects.

When you use a non-social user account, you can also watch ER objects for new comments, to
receive an email whenever another user of ER/Studio Team Server or ER/Studio Repository
adds a comment to the watched ER object.

Additionally, if your ER/Studio Team Server installation does not have any license for Connect
user connections (so it is not possible for any user to log in as a social user), you can add and
delete comments from ER/Studio Team Server.

Topics

e See the Comments to an ER Object

e Watching ER Objects for New Comments

e Adding a Comment to an ER Object

e Deleting a Comment from an ER Object

See Also

e Working with ER Object Labels
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Adding a Comment to an ER Object

Adding a Comment to an ER Object

If your ER/Studio Team Server installation does not have a license for Team Server user
connections (so it is not possible for the user to log in as a social user), you can add comments
to ER objects from ER/Studio Team Server.

Comments let you describe the purpose of ER objects, and highlight certain features to which
you want to draw attention. For example, you may want to use comments to provide feedback
to the author of the model.

@Note: Only non-social users can add comments following the instructions described
in this page. If you have a social user profile, you can add comments using the
Discussions Tab at the navigation sidebar, as explained in Starting a Discussion about a
Resource. For more information, see Using Social Features.

To add a comment to an ER object:

1. Go to the description page of the target ER object.

2. Expand the Comments section, at the bottom of the page.
3. Click Add comment. A text field and two buttons appear.
4. Write your comment in the text field.

5. Click Add to add your comment to the ER object.

Your comment is added to the target ER object description page, where any other non-social
user can see it.

Super users can configure ER/Studio Team Server so that your comments are not published
until a super user reviews them. In that case, you receive the following message after you write a
comment to an ER object:

"Comment added. It will be viewable once the moderator has approved it."

For more information, see Comment Moderation Page.

@Note: When you synchronize ER/Studio Team Server with ER/Studio Repository,
comments are synchronized as well. Synchronization works both ways: comments in
ER/Studio Team Server become available in ER/Studio Data Architect or ER/Studio
Business Architect, and comments in ER/Studio Data Architect or ER/Studio Business
Architect become available in ER/Studio Team Server.

See Also

e Watching ER Objects for New Comments

e Deleting a Comment from an ER Object

e See the Comments to an ER Object
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Adding a Comment to an ER Object

e Discussing Resources
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Deleting a Comment from an ER Object

Deleting a Comment from an ER Object

You can delete your own comments or, if you are a super user, you can delete any comment. To
delete a comment:

1. Go to the description page of the target ER object.

2. Expand the Comments section, at the bottom of the page.
3. Click the Wbutton on the right-hand side of the comment box.

4. When asked for confirmation, click OK to delete your comment.

See Also

e Adding a Comment to an ER Object
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See the Comments to an ER Object

See the Comments to an ER Object

To see the comments to an ER object, do either of the following:

e Inthe Model Explorer page, click the "~ icon to the right-hand side of the target ER
object. The Comments page opens with the comments associated with the target ER

object.

e If your ER/Studio Team Server installation does not have any license for social user
connections, you can also go to the description page of the target ER object and
expand the Comments section.

See Also

e Adding a Comment to an ER Object

e Watching ER Objects for New Comments
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Watching ER Objects for New Comments

Watching ER Objects for New Comments

When you watch an ER object for new comments, ER/Studio Team Server sends you an email
notification when someone posts a new comment on the ER object.

To start watching an ER object for new comments:

1. Open the page of the target ER object. You can search for it.

2. Click =, on the top-right corner, to start watching the target ER object.

Note: If the icon on the top-right is [=], you are already watching the target ER object.

Remember to configure the email address where you want to receive updates about new
comments on the target ER object.

See Also

e Changing Your Email Address for Notifications

e Adding a Comment to an ER Object

e See the Comments to an ER Object

e Following Resources

Embarcadero Technologies 115



Working with ER Object Labels

Working with ER Object Labels

If your ER/Studio Team Server installation does not have any license for social user
connections (so it is not possible for any user to log in as a social user), you can use labels to
organize your ER objects or to mark them somehow. For example, you can label a set of ER
objects that have something in common, so that you can later find them easily.

To see the labels associated with an ER object, go to the description page of the target ER
object and expand the Labels section.

Topics

e Editing the Labels of an ER Object

See Also

e Working with ER Object Comments
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Editing the Labels of an ER Object

Editing the Labels of an ER Object

To edit the labels associated with an ER object:

1.
2.
3.

4,
5.

Go to the description page of the target ER object.

Expand the Labels section, towards the bottom of the page.

Click Add labels or Edit labels. It is the same action, the name depends on whether or
not there are labels associated with the current ER object already.

You are now in edit mode. Now you can add and remove labels to the current ER object.

When you are finished editing the ER object labels, click Done to save the changes.

When you are in edit mode:

You can enter a label in the text field and click Add to associate the entered label with
the current ER object.

Under the text field, you can see a list of existing labels from other ER objects (if any).
Click a label from the list to associate it with the current ER object.

To remove a label from the current ER object, click the * button to the right-hand side
of the target label.
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Overview of the User Interface

The ER/Studio Team Server user interface consists of the following elements:

Global Search Box

_ UserMenu s seses: e ou
Navigation Menu

Model Explorer
My Neports

Sthared Reports

Navigation
Sidebar Page Body

em Embarcadero Team Server Version 4.0
Busld Id: 4.0-201404111701

e Global Search Box. Lets you search for any resource in the Reporting Repository.

e User Menu. Provides access to user features and settings.

¢ Navigation Menu. Provides access to the main ER/Studio Team Server features.

e Navigation Sidebar. Lets you switch between the different pages of a major section. It
changes depending on the current section.

e Page Body. Shows the content of the current page.

Page Index

This is a list of pages and types of pages that you can find in ER/Studio Team Server:

e Login Page
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Overview of the User Interface

e Resource Pages

e Report Pages
e Search Pages

See Also
o User Guide
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Global Search Box

Global Search Box

1

The Global Search Box is a search box which is always available in the upper-right corner of the
ER/Studio Team Server user interface.

To perform a search, enter your search terms into the search box and press <. What
happens then depends on your type of user account:

e Ifyou are a social user, ER/Studio Team Server opens a global search page, a search
page that includes every kind of resources: ER objects, people, glossaries, and so on.

e If you are a non-social user, ER/Studio Team Server opens the Simple Search page with
the results for your search. In this case, you can use special syntax features in your search

string.
See Also
e Searching

e Search Pages
e Simple Search page
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Simple Search

Simple Search

| seargh |

Global Search Box | enter a search string | press ¢ (non-social users)

This page lets you search ER/Studio Team Server for ER objects.

The Simple Search page shows the results of your search at the top of the page, followed by
the simple search form.

See Also

o Global Search Box
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Simple Search Form

Simple Search Form

The simple search form is part of the Simple Search page.

To preform a search, enter a search string into the search box and click the Search button.

Search | Advanced

See Also

e Global Search Box

e Search Results
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Search Results

Search Results

Go Up to Simple Search
Go Up to Advanced Search

The search results frame is displayed:

e Inthe Advanced Search page, after you perform an advanced search.

e Inthe Simple Search page, after you perform a simple search as a non-social user.

The search results for an advanced search have:
e Aheader, on top, with several options and actions.

e The results panel.

e A panel with filters to apply to the search results.

Results Header

Above the search results, you can access the following options and actions:
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Search Results

[tem Description

View as table |Switches the search results view between the HTML view (default) and the table view.
View as html

Hide details |Hides or shows the details in the search results.

View de‘;alls If you hide the details, search results provide only show the breadcrumb trail and the
(HTML view) | relevance. See Results Panel.

WF Opens a window to add the current advanced search to your list of Favorite Searches. See
Add to Saving Favorite Searches.

favorites

== Opens a window to send the current advanced search by email. See Sending Searches By
Send by Email.

email

= Opens a printable version of the current search results, and asks your web browser to
Print print it.

iy

: Opens the Search Results Configuration page, where you can customize the search
Configure  [results table view.

this view

(table view)

Order By Lets you configure the search field to sort the results, and the order, either ascending or
(HTML view) |descending. By default, most relevant results come first.

Click a field name to select it to sort the results. The ascending () or descending ()
icon is displayed on the right-hand side of the field name. You can click the field again to
switch between ascending and descending order.

Tip: You can further customize the search results using the table view with
Configure this view.

Results Panel

In the results panel, the data matching the search string is marked in bold.

While the data displayed is the same, the aspect of the results panel changes depending on the
selected type of view: the HTML view or the table view.

When you use the HTML view, each item in the list of results provides the following information:
e Inthe first row, you can see:
o Anicon that identifies the type of ER object.

o The breadcrumb trail to the ER object, including the ER object itself. For
example: Parent ER Object > Matching ER Object. Each ER object in the
breadcrumb trail links to its ER object description page.
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Search Results

o A percentage, between parenthesis, that represents the relevance of the
matching ER object, given the search criteria used.

e Inthe second row, you can see:
o The date of the last modification to the matching ER object.
o The author of the last modification to the matching ER object.

e There are additional rows displaying a variety of property-value pairs. These rows
depends on the ER object type of the matching ER object, for each ER object type a
different set of rows is displayed.

When you use the table view, ER/Studio Team Server displays the same data, but in columns:
Column Description

Object Name [The name of the ER object.

Object Type |The type of ER object.

Relevance The relevance of the matching ER object (in percentage), given the search criteria used.

Modification |[The date of the last modification to the matching ER object.
Date

User Name  [The author of the last modification to the matching ER object.
Path The breadcrumb trail to the ER object, including the ER object itself. For example:

Parent ER Object > Matching ER Object. Each ER object in the breadcrumb trail links to
its ER object description page.

Property Type |Property-value pairs that provide additional information about the ER object. The
Property property-value pairs depend on the ER object type of the matching ER object, for each
Value ER object type a different set of property-value pairs is displayed.

Click a column name to select it to sort the results. The ascending (") or descending (%) icon is
displayed on the right-hand side of the column name. You can click the column again to switch
between ascending and descending order.

Filters Panel

The filters panel is displayed on the right-hand side of the results panel when you use the HTML
view, or at the bottom of the results panel when you use the table view.

In the panel, you can find a variety of filtering options to apply to the search results. Each
filtering option has the following appearance:

Filter By <Filter type> ¢
v @<Filter name> (<Filter count>)

v @<Filter name> (<Filter count>)
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The following table explains each part of a filtering option in detail:

ltem Description

Filter type The type of filter. This can be:

e Obiject Type(s), to filter the search results by the ER object type of the
matching ER object.

e An ER object type that one or more matching ER objects have as
parent (for example, Diagram(s)), to filter the search results by
common parent.

"/ Click this icon to hide (*%) or show ("7) the filters available in the current filtering
Hide / Show option.
filters

)@ Click this icon to switch on or off the limit of filters that can be listed in the current
Limited / filtering option:

Unlimited filters ) ) o
I Listed filters are limited.

@ All filters are listed.

o Adds the filter on the right-hand side of the icon to the list of active filters, as a
Make mandatory |mandatory filter. Only search results matching the selected filter are displayed.

@ Adds the filter on the right-hand side of the icon to the list of active filters, as an
Make excluded |excluded filter. Search results matching the selected filter are not displayed.

Filter name The name of the filter. The filters depend on the Field type:

o Ifitis Object Type(s), each filter name is an ER object type (for
example, Model or Entity).

e Ifitis an ER object type, each filter is the name of an actual ER object
that is a common parent to one or more ER objects in the search
results.

Filter count The number of matching ER objects in the search results that match the filter.

When you add a mandatory (+) or excluded (@) filter to the list of active filters, ER/Studio Team
Server displays the list of active filters after the last filtering option. The list of active filters has
the following appearance:

Current Active Filter(s)ﬁf
<Filter mode> <Filter type>: <Filter name> W

<Filter mode> <Filter type>: <Filter name> (1]
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The following table explains each part of the list of active filters in detail:

[tem Description

] You can click the T icon on the left-hand side of Current Active Filter(s) to remove all
Remove active filters.

Click the W icon to the left-hand side of a specific filter to remove only that filter.
v/ @ This is an icon representing the filter mode, either mandatory (+) or excluded (@).
Filter
mode

Filter type |The type of filter. For more information, see the table above.

Filter name [The name of the filter. For more information, see the table above.

See Also

e Using the Advanced Search of ER Obijects
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Search Results Configuration
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The search results configuration page lets you customize the appearance of the table view in
the Search Results page.

This page displays the search results with editable column headers, so that you can remove or
reorder the table columns, and a set of actions to interact with the page.

Each value in the Property Type column has a @icon on the right-hand side. You can click that
icon to hide the target property type in the search results table.

Below the table, there is a page navigation menu with page numbers and Previous and Next
buttons that you can use to browse the pages of search results.

Column Header Actions

Each column header in the search results configuration table provides the following actions:
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Search Results Configuration

ltem Description

= Switches the current column with the column on its left-hand side.
Shift column to the left

() Hides the current column.
Hide column

= Switches the current column with the column on its right-hand side.
Shift column to the right

Search Results Configuration Actions

At the top and at the bottom of the search results configuration page you can access the
following actions:

ltem Description

Apply Changes |Saves your changes to the search results table, and goes back to the Search Results

page.
Restore Restores the factory defaults, displaying all columns (in the default order) and property
Defaults types.
Cancel Goes back to the Search Results page without saving your changes.
Changes
See Also

e Advanced Search page
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Resource Pages

Resource Pages

While non-social users can only interact with ER objects, social users enjoy access to other kind
of resources: glossaries, terms, people, and data sources.

The pages of each one of those types of resources have a couple of things in common:

Company Glossary
s | o ' Resource
Terms Header

Followers

Navigation Subpage Body
Sidebar

e Navigation Sidebar. Allows you to switch between the different subpages of your
resource. Different types of resource provide different subpages.

e Resource Header. The resource header displays an icon representing the resource, the
name of the resource, and some additional information and actions, depending on the
type of the resource.

e Subpage Body. This area displays the content of the resource subpage selected in the
navigation sidebar.

The following table shows the list of the existing resource pages (first row), and their respective
subpages (second row):
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Glossary Pages

Term Pages

Stream

Descriptio
n

Terms

Discussion

S

Followers

Children

e Stream
e Descriptio
n

e Discussion

S

e Followers

e Related
Glossaries

e Related
Terms

e Related
ER

Obijects

Resource Pages

Person Pages

ER Object Pages |Data Source Pages

Stream

Descriptio
n

Followers

Following

Stream

Descriptio
n

Discussion

S

Followers

Related
Terms

Related
Data
Sources

Alerts

Stream

Descriptio
n

Discussion
s

Followers

Related
ER Models

When you open a resource page, the Description subpage, common to all resource pages, is

opened by default.

See Also

Searching
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Glossary Pages

Glossary Pages

Glossary pages provide information about glossaries: activity, details, terms included,
discussions about them, people who are following them, and child glossaries. They are only
available for social users.

To open a glossary page, follow a glossary link. There are several places where you can find
glossary links, but if you are looking for a specific glossary, you can try the Glossaries search

page.

Glossary pages share a common header, and they also share a common sidebar. When you click
the items in the sidebar, you get access to information pages about different aspects of the
target glossary.

Glossary Pages Header
u Business Strategy Newrem J| _rotowing ]

The glossary page header shows:
e Aglossary icon.
e The name of the glossary.
e The type of resource ("Glossary").

e If you are the owner of the glossary or an super user, you can click [Delete] to delete the
glossary.

On the top-right corner:

e If you are the owner of the glossary or an super user, you can click New Term to add a
new term to the glossary.

e You can click + Follow to start following the current glossary, or Following to stop
following it. See Following Resources.

Glossary Pages Sidebar

Glossary pages provide a sidebar with the following items:
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Glossary Pages

ltem Description

Opens the activity stream of the current glossary.
Stream It displays entries, for example, when a term is associated with the current glossary.
The sidebar shows:

e Followers. A list of users that are following the current glossary. See the
Followers subpage.

e Terms. A list of terms associated with the current glossary. See the Terms
subpage.

o Children. A list of glossaries that are a child of the current glossary. See the
Children subpage.

Provides detailed information about the glossary.

Description
B Shows a list of terms that are associated with the current glossary.
Terms

Opens the list of discussions about the current glossary.
Discussions

Shows a list of users that are following the current glossary.
Followers
|! Shows a list of glossaries that are a child of the current glossary.
Children

Opens the users and groups permissions tab for the glossary.
Permissions

See Also

o Working with Glossaries
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Glossary Description

Glossary Description
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The Description subpage of glossary pages provides detailed information about a glossary.

The page is divided in two columns:
e The details column on the left-hand side.

e The stewards column on the right-hand side.

Details Column

The details column provides the following fields:

[tem Description

Author and Date |On the top of the page, you can see the following text indicating the user who
originally created the glossary, and the date when it was created:

Created by <Author> on <Date>

Edit On the right-hand side of the author and date information, there is an Edit button
that you can click to enter the edition mode.

In the edition mode, you can edit the glossary data, and click Save at the bottom of
the page to save your changes, or Cancel to revert them.

Name Name of the glossary.

Status Text describing the status of the glossary.
Description Detailed description of the glossary.
Abbreviations List of abbreviations of the glossary.

Aliases/Synonyms |List of aliases and synonyms of the glossary.

User Data Custom information related to the business object that only you can see.

Other users, including super users, cannot see the information in this field.

Stewards Column

The stewards column provides a list of Stewards, users with permission to edit the glossary.
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Glossary Description

If you are on that list, you can click Edit there to add or remove people from the list.

See Also

e Working with Glossaries
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Children

The Children subpage of glossary pages list the glossaries that have the current glossary as a
parent.

You can use this page to add or remove children of the current glossary.
The page is divided in two tabs:
e The View tab displays a list with the glossaries that are a child of the current glossary.

e The Manage tab lets you add or remove children from the current glossary.

Manage Tab

The content of the Manage tab is similar to the content of the Glossaries page. For example, it
has a search box as well, and letters to navigate the matching glossaries.

On the right-hand side of the glossary entries, you can click Add Child to make a glossary a
child of the current glossary, or you can click Remove Child to remove the target glossary from
the list of children of the current glossary.

On the top of the list of glossaries, you can click Add All to make all the listed glossaries
children of the current glossary, or you can click Remove All to remove all the listed glossaries
from the list of children of the current glossary.

See Also

e Adding a Child to a Glossary
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Term Pages

Term Pages

Term pages provide information about terms: activity, details, discussions about them, people
who are following them, and related glossaries, ER objects and other terms. They are only
available for social users.

To open a term page, follow a term link. There are several places where you can find term links,
but if you are looking for a specific term, you can try the Terms search page.

Term pages share a common header, and they also share a common sidebar. When you click
the items in the sidebar, you get access to information pages about different aspects of the
target term.

Term Pages Header
Marketing [ Fotow

Business Term
The term page header shows:
e Atermicon.
e The name of the term.
e The type of resource ("Term").

e If you are the owner of the term or a super user, you can click [Delete] to delete the
term.

On the top-right corner, you can click + Follow to start following the current term, or Following
to stop following it. See Following Resources.

Term Pages Sidebar

Term pages provide a sidebar with the following items:
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Term Pages

[tem Description

Opens the activity stream of the current term.
Stream It displays entries, for example, when a term is related to a glossary.

The sidebar shows:

e Followers. A list of users that are following the current term. See the
Followers subpage.

o Related Glossaries. A list of glossaries that are related to the current
term. See the Related Glossaries subpage.

e Related Terms. A list of terms related to the current term. See the
Related Terms subpage.

e Related ER Objects. A list of ER object related to the current term. See
the Related ER Objects subpage.

Provides detailed information about the term.

Description

Opens the list of discussions about the current term.
Discussions

Shows a list of users that are following the current term.
Followers
|! Shows a list of glossaries that are related to the current term.
Related
Glossaries
E Shows a list of terms that are related to the current term.

Related Terms

Shows a list of ER Obijects that are related to the current term.
Related ER
Objects

See Also

e Working with Terms

o Working with Glossaries

o Working with ER Objects
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Term Description

Term Description
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The Description subpage of term pages provides detailed information about a term.
The page is divided in two columns:

e The details column on the left-hand side.

e The stewards column on the right-hand side.

Details Column

The details column provides the following fields:

Item Description

Author and Date |On the top of the page, you can see the following text indicating the user who
originally created the term, and the date when it was created:

Created by <Author> on <Date>

Edit On the right-hand side of the author and date information, there is an Edit button
that you can click to enter the edition mode.

In the edition mode, you can edit the term data, and click Save at the bottom of the
page to save your changes, or Cancel to revert them.

Name Name of the term.

Status Text describing the status of the term.
Description Detailed description of the term.
Abbreviations List of abbreviations of the term.

Aliases/Synonyms |List of aliases and synonyms of the term.

User Data Additional information about the business object.

Stewards Column

The stewards column provides a list of Stewards, users with permission to edit the term.

If you are on that list, you can click Edit there to add or remove people from the list.
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See Also

e  Working with Terms
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Related ER Obijects

]

The Related ER Objects subpage of term pages lists the ER objects that are either related to
the current term, or that contain the term in their name or other property values.

You can use the related ER Objects page to relate or unrelate and match or unmatch ER
objects to the current term.

The page is divided in three tabs:
e The View Tab.
e The Found In tab lets you match and unmatch ER objects to the current term.

e The Relate tab lets you relate and unrelate ER objects to the current term.

View Tab

displays a list of related and matching ER objects. The list shows the related ER objects first, and
then the matching ER objects.

B I
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Found In Tab

The content of the Found In tab is similar to the content of the ER Objects page. For example,
it has a search box as well, and letters to navigate the matching ER objects.

You can click the Refresh button, right below the list of letters, to perform an automatic match
against existing ER objects. ER/Studio Team Server automatically matches any ER object
containing the current term.
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Related ER Objects

On the right-hand side of the ER object entries, you can click Unmatch to unmatch matching ER
objects, or click Re-Match to match ER objects that you manually unmatched.
ER Objects
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Relate Tab

The content of the Relate tab is similar to the content of the ER Objects page as well, and it
also has a search box and letters to navigate the matching ER objects.

On the right-hand side of the ER object entries, you can click Relate to relate a ER object to the
current term, or you can click Unrelate to unrelate the target ER object from the current term.

On the top of the list of ER objects, you can click Relate All to relate all the listed ER objects to
the current term, or you can click Unrelate All to unrelate all the listed ER objects from the
current term.

See Also

e Associating a Term with an ER Object

e Matching a Term with ER Objects
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Related Glossaries

Related Glossaries

The Related Glossaries subpage of term pages lists the glossaries related to the term.

If you are a steward of the term, you can use this page to relate or unrelate glossaries to the
term. With the exception of Child Glossaries that are inherited and cannot be unrelated.

The page is divided in two tabs:
e The View tab displays a list with the glossaries related to the term.

e The Relate tab lets you relate and unrelate glossaries to the term.

Relate Tab

The content of the Relate tab is similar to the content of the Glossaries page. For example, it
has a search box, and letters to navigate the matching glossaries.

On the right-hand side of the glossary entries, you can click Relate to relate a glossary to the
term, or you can click Unrelate to unrelate the target glossary from the current term.

On the top of the list of glossaries, you can click Relate All to relate all the listed glossaries to
the current term, or you can click Unrelate All to unrelate all the listed glossaries from the

current term.

See Also

e Associating a Term with a Glossary

e Terms page

e  Working with Terms

e Working with Glossaries
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Data Source Pages

Data Source Pages

Data source pages provide information about data sources: activity, details, discussions about
them, people who are following them, and related ER models. They are only available for social
users.

To open a data source page, follow a data source link. There are several places where you can
find data source links, but if you are looking for a specific data source, you can try the Data
Sources search page.

Data source pages share a common header, and they also share a common sidebar. When you
click the items in the sidebar, you get access to information pages about different aspects of
the target data source.

Data Source Pages Header
W= sales Data i

Data Source

The data source page header shows:
e A data source icon.
e The name of the data source.
e The type of resource ("Data Source").

e If you are the owner of the data source or a super user, you can click [Delete] to delete
the data source.

On the upper-right corner, you can click + Follow to start following the current data source, or
Following to stop following it. See Following Resources.

Data Source Pages Sidebar

Data source pages provide a sidebar with the following items:

@Note: Related ER Models is available if there is an ER/Studio Team Server License
registered. Related Login Credentials and Monitory are available if there is a DBArtisan Team
Sever License registered
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Item

Stream

Description

Discussions

Followers

Related ER Models

Related Login
Credentials

Monitoring

Permissions

See Also

Data Source Pages

Description

Opens the activity stream of the current data source.
Displays entries, for example, when a data source is related to an ER model.

The sidebar shows:

e Followers. A list of users that are following the current data
source. See the Followers subpage.

Provides detailed information about the data source.

Opens the list of discussions about the current data source.

Shows a list of users that are following the current data source.

Shows a list of ER models that are related to the current data source.

Shows a list of Login Credentials that are related to the current data source.

Opens the Monitoring page of the current data source

Opens the users and groups permissions tab for the data source.

o Working with Data Sources
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Data Source Description
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The Description subpage of data source pages provides detailed information about a data
source.

The page is divided in two columns:
e The details column on the left-hand side.

e The stewards column on the right-hand side.

Details Column

The details column provides the following fields:
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Item
Name

Type

<Database Management
System Fields>

Custom Properties

Description
Abbreviations
Aliases/Synonyms

User Data

Monitoring information

Data Source Description

Description
Name of the data source.

Type of database management system (DBMS) of the data source.

The following DBMS are supported: DB2 LUW, DB2 z/OS, InterBase, Firebird,
JDBC, MySQL, ODBC, Oracle, SQL Azure, SQL Server, Sybase, Sybase |1Q.

Depending on the Type of data source, ER/Studio Team Server displays a
different set of fields between the Type and the Custom Properties fields.
See Data Source Fields for a Specific Database Management System.

Custom properties of the data source. For each property you can see a
property name and an associated property value.

Detailed description of the data source.
List of abbreviations of the data source.
List of aliases and synonyms of the data source.

Custom information related to the data source that only you can see.

Other users, including super users, cannot see the information in this field.

List of data source metrics.

Stewards Column

The stewards column provides a list of Stewards, users with permission to edit the data source.

If you are on that list, you can click Edit there to add or remove people from the list.

See Also

o Working with Data Sources

e Data Source Fields for a Specific Database Management System
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Discussions

Discussions

The Discussions subpage of glossary pages, term pages, ER object pages, and data source
pages lets social users discuss any resource of one of those types.

To start a new discussion, click New Discussion on the top-right corner.
The list of discussion topic in the page provides the following columns:

Item Description

Expand/Collapse |You can click the + or - button in this column to expand or collapse a discussion,
respectively.

Topic Title of the discussion.

Started By User who started the discussion.

When you expand a discussion, you can see the complete text of the first message of the
discussion, followed by the replies to the discussions, and then by a text field where you can
write your own reply.

Each entry for a reply to the original discussion message displays:
e The image of the author of the reply.
e The username of the author of the reply.
e The actual text of the reply.
e The date when the user wrote the reply.

e If you are the author of the reply, there is a Delete button on the right-hand side of the
reply date that you can click to delete your reply.

See Also

e Discussing Resources

e Working with Glossaries

e  Working with Terms

e Working with ER Objects
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Discussions

¢ Working with Data Sources
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ER Object Pages

ER Object pages provide detailed information about specific ER objects, in addition to links to
related ER objects. You can follow those links to browse the Reporting Repository.

You can access ER object pages by browsing and searching ER/Studio Team Server.

ER Object pages share a common header, and they also share a common sidebar. When you
click the items in the sidebar, you get access to information pages about various aspects of the
target ER object.

ER Object Pages Header

Credit Card Type

\ B
§ Entity
Y J

Not linked to any term

The ER object page header shows:

e Animage representing the ER object. A default image is shown if the ER object cannot
be represented by an image.

e The name of the ER object.
e The type of the ER object.

e Breadcrumbs with the ER objects that are above the current ER object in the ER object
hierarchy. Here you can click the parents of the current ER object to access their ER
object pages.

e The Linked Term reference or option to create a Linked Term.
On the top-right corner:

e Ifyou are a social user, you can click + Follow to start following the current ER object, or
Following to stop following it. See Following Resources.

e Ifyouare a non-social user, you can click =Jto start watching the current ER object for
updates, or [=lto stop watching it. See Watching ER Objects for New Comments.

ER Object Pages Sidebar

The sidebar in ER object pages provides different items depending on your user type: social or
non-social.

Sidebar for Social Users

When you are a social user, ER object pages provide a sidebar with the following items,
depending on the ER object type:
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ER Object Pages

ltem Description

Opens the activity stream of the current ER object.

Stream
Provides detailed information about the ER object, with links to related ER
Description objects. This page looks different depending on the type of the current ER
object.
Opens the list of discussions about the current ER object.
Discussions
Shows a list of users that are following the current ER object.
Followers
B Shows a list of terms that are associated with the current ER object.

Related Terms

Shows a list of data sources that are associated with the current ER object.
Related Data Sources

) Lets you configure conditions that raise alerts about sensitive data.
Alerts

(only security properties

and attachments)

Opens the users and groups permissions tab for the current diagram, model
Permissions or submodel.

Note: The Stream, Discussions, and Followers entries in the sidebar of an ER object
page are disabled until you perform some social interaction with the target ER object.
To enable them you can, for example, start following the target ER object.

Sidebar for Non-Social Users

When you are a non-social user, ER object pages provide a sidebar with a single item:
Description.

See Also

e Working with ER Objects
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Alerts

Alerts

Mew Condition Alert X

Show Alert for Matching
# Bound Object
C value
Matching Value
|None 'l
Alert Level
' Warning
® Info
Notification Text

Alerts subpage provides detailed information about the conditions alerts that a Security
Property or an Attachment has. If an alert condition matches an ER object, ER/Studio Team
Server displays on the header of an ER object page, the alert message and icon defined in the
alert condition.

You can access the Alerts subpage by clicking the Alerts Icon at the common sidebar from a
Security Property or Attachment page.

This page provides an action on top, New Condition. You can click this action to add a new
alert condition entry to the page.

Super users can edit and delete any alert condition, however authenticated users can only edit
and delete those alert conditions that they create.

Alert Condition Entries

Each alert condition entry in the page provides the following fields:
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Alerts

[tem Description

Show Alert |Here you can define the condition that should result in showing the target alert on any
for matching ER object. You may choose any of the following values:

Matching
e Bound Object. Show the target alert for any object bound to the current

security property or attachment.

e Value. Show the target alert for any object bound to the current security
property or attachment where the security property or attachment has the
specified value. You can specify the target value on the text input field on
the right-hand side of Value.

Alert Level [The level of the alert, which determines which icons ER/Studio Team Server displays
along with the defined Notification Text. You may choose any of the following values:

e Info.

e Notice.

The following image shows the header of an ER object with one alert of each type and a
Notification Text equal to the name of the chosen Alert Level.

ContactCreditCard

Entity
Adventure WorksNVE.dml > Logical » ContactCreditCard

Mot linked to any term [Create Linked

*Confidential Information™ Protected under the DLP.A.

®[ ustomer information

ER/Studio Team Server displays this text on the header of matching ER objects, on the
right-hand side of the icon representing the Alert Level.

Notification |Text of the alert.
Text

Delete Deletes the target condition.
Condition

(only super

users and

alert

condition

author)

Note:ER/Studio Team Server saves changes to field values as fields lose focus.

See Also

e Configuring Sensitive Data Alerts
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Alerts

e Data Source Alerts

e Object Alerts page

Embarcadero Technologies 154


http://docwiki.embarcadero.com/TeamServer/ERStudio/en/Data_Source_Alerts
http://docwiki.embarcadero.com/TeamServer/ERStudio/en/Object_Alerts

ER Object Description

ER Object Description
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The Description subpage of ER object pages provides detailed information about an ER object.

The content of the page varies from one ER object type to another. However, when you are a
non-social user, all of them provide the following two sections at the end of the page:

ltem Description

Labels Lets you view and manage the current ER object labels.

Comments |Lets you view the comments to the current ER object. You can add, edit or delete your own
comments, or any comment if you are an super user.

This is a list of available ER object description pages:
e ER Object description pages for ER/Studio Data Architect object types:
o Attachment

o Attachment Type

o Attribute/Column

o Bound Attachment

o Bound Data Movement Rule

o Bound Security

o Data Lineage Column

o Data Lineage Source/Target

o Data Lineage Table

o Data Movement Column

o Data Movement Rule

o Default
o Diagram
o Dictionary

o DL Transformation
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o

o

e ER Object description pages for ER/Studio Business Architect object types:

o

o

o

Domain

Entity/Table
Key/Index

Lineage Data Flow

Lineage Data Stream

Model

Reference Value

Relationship

Security Property

Security Type
Submodel

User Datatype
View

View Column

BM Annotation

BM Assignment

BM Association

BM BusinessAttribute

BM BusinessElement

BM BusinessEntity

BM BusinessUnit

BM DataElement

BM DataObject

BM DataSource

BM DataStore

BM_Diagram
BM Domain

BM Event
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o

See Also

BM Gateway

BM_Group
BM Lane

BM_ Link
BM_Model

BM Message Flow

BM PDiagram
BM Pool

BM Process

BM Project
BM_Property
BM_PProperty

BM ReferenceColumn

BM ReferenceEntity

BM_Relationship

BM Rule

BM Sequence Flow

BM Steward
BM SubjectArea

BM Task

BM_Trigger

BM Usage
BM Workspace

e Working with ER Objects
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Troubleshooting

Here you can find a list of some frequently encountered problems and their solutions or
workarounds.

Most problems can be fixed by making sure that your system is running the latest software.
Before you start troubleshooting, it is advised that you make sure your product is up to date.

Cannot Connect to ER/Studio Team Server

Unable to Connect
If your web browser cannot establish a connection to the ER/Studio Team Server server:
o Check that the URL you are trying to access is ER/Studio Team Server's.

e Check that your system has a working connection to the ER/Studio Team Server server.

e Check that ER/Studio Team Server is running. See Starting ER/Studio Team Server.

e Tryincreasing the maximum memory assigned to ER/Studio Team Server. See Changing
the Memory Limit of ER/Studio Team Server.

Template Could Not be Loaded
"Template could not be loaded..."

If you get this error message, you might need to restart the ER/Studio Team Server server.
Contact your super user.

Loading Pages Takes Too Much Time

Try increasing the maximum memory assigned to ER/Studio Team Server. See Changing the
Memory Limit of ER/Studio Team Server.

Log Error Messages

There are some log files in the ER/Studio Team Server installation folder that you can watch for
error messages and warnings. Here you can see some errors that you might see registered in
those log files, what the errors mean, and how to solve them.

tomcat\logs\<domain>.<date>.log

java.lang.OutOfMemoryError: Java heap space

You need to increase the maximum memory assigned to ER/Studio Team Server. See Changing
the Memory Limit of ER/Studio Team Server.
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etlvar\log\log_<timestamp>\*.log

<date> - SyncDiagram.bat (stdout) - Could not reserve enough space for object heap

The application cannot start because there is not enough contiguous memory in the system that
can be allocated for the application. For example, you are using a virtual machine and have
more memory allocated to ER/Studio Team Server than is available on the virtual machine.

You need to decrease the maximum memory assigned to ER/Studio Team Server. See
Changing the Memory Limit of ER/Studio Team Server.

Synchronization Issues

Oracle

The default number of processes that can be set in Oracle XE is 40. If you exceed the amount of
processes you may get a failure, identified in the synchronization logs as ORA-12519, TNS:no
appropriate service handler found. The synchronization logs are available in the installation
dir\etlvar directory.

To fix this error you can increase the number of available processes by doing the following:

1. Run SQL*Plus and login as SYSTEM. You should know what password you've used
during the installation of Oracle DB XE.

Run the command

“ALTER SYSTEM SET processes=150 scope=spfile;”

g WIN

in the SQL*Plus
6. Restart the database.

If you continue to get this error after increasing the number of available processes by following
the above procedure, you may be using up all available processes and need to source the
reason for this by examining the processes.

Connect to your database either using the sys account or by logging into your Oracle server
and using a direct SQL Plus connection as the Oracle user: sqlplus / as sysdba.

@Note: If you are still getting errors regarding no available processes, you will have to
manually kill one of the Oracle processes using the kill command. Then use these two queries to
find out how many processes and sessions are currently logged:

1 SELECT COUNT (*) FROM vS$process;
2 SELECT COUNT (*) FROM vSsession;
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For Oracle 11g, the default maximum number of processes is 150 (149 available).

Once you have confirmed that you have definitely reached the maximum number of processes,
you can use this query to see what they all are and if they are active:

1 SELECT sess.process, sess.status, sess.username, sess.schemaname, SQL.sgl text
2 FROM v$session sess, v$sql SQL
3 WHERE SQL.sgl id(+) = sess.sql id;

See Also

e Overview of the ER/Studio Team Server Tools

e Overview of Data Synchronization
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Glossary

Here you can find information about some of the terms that you may run into while you browser
the documentation.

A

Apache Tomcat

Server technology used by ER/Studio Team Server. More information.

B

Breadcrumb trail

A breadcrumb trail is a structured display of resources where the resource to the left is a
parent of the resource to the right.

¥ Model1.DM1 > [E Logical > [ Main Model
Business Reports

This is one of the folders of shared reports distributed with ER/Studio Team Server. See
Solution Browser, Business Reports.

C

Connection Types

These are the type of connections that people can use to connect to ER/Studio Team
Server. Not to be confused with user types. See Overview of User Connections.
CRUD

Create, Read, Update, Delete usage relationships.

D
Diagram

A graphical presentation of a collection of model elements.
Digital Certificate

A digital certificate (also known as a public key certificate or identity certificate) is an
electronic document that uses a digital signature to bind a public key with identity
information. The certificate can be used to verify that a public key belongs to an
individual. You can view installed certificates in Firefox > Options > Advanced Menu.

- [ — =] - |
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ETL

Extraction, Transformation and Load, a process in data warehousing that involves
extracting data from other sources, transforming it to fit business need, and then
loading it into an end target, such as the data warehouse.

L

Logical Model

A logical entity-relationship model conforms to relational theory and contain only fully-
normalized entities. For a logical data model to be normalized, it must include the full
population of attributes to be implemented and those attributes must be defined in
terms of their domains or logical data types.

A logical data model requires a complete schema of identifiers or candidate keys for
unique identification of each occurrence in every entity. The logical model indicates the
current identify selection because there are choices of identifiers for many entities.

P

Pentaho BI Platform

Architecture and infrastructure to build solutions to business intelligence (BIl) problems.
ER/Studio Team Server builds its reporting features on top of this platform. More
information.

Permissions

Gives a user the ability to access the Reporting Repository database. See Overview of
User Roles.
Physical Model

A complete physical data model includes all the database artifacts required to create
relationships between tables and achieve performance goals, such as indexes, constraint
definitions, linking tables, partitioned tables, and clusters.

R

Roles

ER/Studio Team Server provides default roles. These roles are granted permissions to
access actions. The default roles are Authenticated and Super User. See Overview of
User Roles.

Repository

A database where ER/Studio Team Server stores and maintains data. For ER/Studio
Team Server, the database, or repository, is associated with the ER/Studio application.
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S

Security

All users are authenticated before they are able to run queries and reports. Each user
must have a user name and password that is stored in the ER/Studio Repository
database.

Solution

A set of documents defining the processes and activities required to solve a specific
business intelligence problem.
Solution Repository

The Solution Repository is the location where solutions and the metadata they rely on is
stored and maintained. Requests made to the platform to have actions executed rely on
the action being defined in the Solution Repository.

Scheduler

Administrative function to schedule and monitor synchronization of the ER/Studio
Repository with the Reporting Database. See Overview of Scheduling.

T

Technical Reports

This is one of the folders of shared reports distributed with ER/Studio Team Server. See
Solution Browser, Technical Reports.

See Also

e Whatls ER/Studio Team Server

e Overview of the ER/Studio Team Server Architecture
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